
Frontpage 2002 
 

Ngày nay, Internet và đặc biệt là World Wide Web đã trở thành một dịch vụ 
thông tin gắn chặt với đời sống kinh tế-xã hội. Trong giáo dục, việc truy cập 
thông tin và tạo ra thông tin trở thành một công việc thường xuyên của thầy 
giao và học sinh Ngoài các chương trình trong MS Office như Word, Excel, 
chương trình Frontpage cho phép mọi người dễ dàng tạo ra các trang Web 
sinh động đầy màu sắc, đồng thời chuyển tải các trang đó lên mạng Internet 
một cách thuận tiện nhanh chóng.. 

Tài liệu sau đây được trích lược từ tài liệu huấn luyện gốc của Microsoft  
(Microsoft® FrontPage® 2002 Tutorial) 

Mục tiêu của tài liệu này là giúp cho các thầy cô giáo : 

 Tạo được một trang Web và một Web site đơn giản theo hướng 
dẫn từng bước. 

 Làm quen với ngôn ngữ HTML và các khái niệm, các thuật ngữ 
trên mạng Internet  và dịch vụ WWW. 

Tài liệu này không có tham vọng đề cập đến tất cả các chức năng của 
Frontpage  cũng như các thao tác và kỹ năng đầy đủ, nó chỉ có tính giới thiệu 
một số khái niệm và kỹ năng cơ bản. Người học sau đó có thể tự tìm hiểu 
thêm qua các giáo trình khác đầy đủ hơn, hoặc qua kinh nghiệm sử dụng 
thực hành soạn giảng Web site giáo dục. 

Để có thể sử dụng được tài liệu này, người học cần có đĩa chứa tập tin  
FPTutorial.zip được cung cấp kèm theo tài liệu, tập tin này được giải nén vào 
một thư mục nào đó trên đĩa cứng. Các hình ảnh, văn bản trong thư mục là 
những tài nguyên được sử dụng làm ví dụ mẫu. Cũng chính vì lý do đó, tài 
liệu này giữ nguyên các nội dung tiếng Anh có liên quan đến chủ đề của các 
trang Web được tạo ra. Hy vọng nó không gây khó khăn lắm cho người học. 
Phần câu hỏi trắc nghiệm được xem như phần bổ sung kiến thức chứ không 
phải đề thi mẫu..

  205 



Microsoft FrontPage 2002 

Chương 1 : Tạo trang Web 
 

Tổng quan 

Kỹ năng rèn luyện : 
• Mở FrontPage. 
• Tạo trang Web. 
• Làm việc với văn bản và liên kết 
• Chèn hình ảnh và tập tin.  
• Định dạng danh sách  
• Định vị các đối tượng. 
• Thiết kế bộ sưu tập ảnh. 
• Tạo cấu trúc  Web site. 
• Lưu. 

Mở FrontPage 

• Trên thanh tác vụ Windows, bấm nút Start , chọn Programs, và chọn 
Microsoft FrontPage. 

 
Nếu đây là lần đầu tiên bạn mở FrontPage, một trang trắng được tạo ra sẵn. 

 
Chú ý 

o Nếu FrontPage được sử dụng để hiệu chỉnh một Web site nào đó, nó sẽ tự 
động mở Web site đó mỗi lần khởi động. 

 
o Đề đóng Web site: vào menu File, chọn Close Web. 

Cửa sổ  Frontpage 

 
 
Các thành phấn Mô tả 
Page Tab Dùng để chọn trang làm việc. 
Title Bar Hiển thị tên cuả trang Web và vị trí cuả trang 

trong Web site. 
Menu Bar Chứa các thực đơn lệnh. 
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Ask a Question Box Hổ trợ người sử dụng khi cần hướng dẫn 
thực hiện các thao tác 

Close Page Đóng trang hiện hành. 
Scroll Bars Dùng để di chuyển trên trang hiện hành. 
Status Bar Thanh trạng thái, thường dùng để quan sát 

đích cuả các liên kết. 
Page View Panes Các khung hiển thị trang: Gồm 3 chế độ 

normal, html và preview. 
Progress Indicator Chỉ thị cuả tiến trình. 
Estimated Download Time Thời gian tải trang ước lượng. 
Task Pane Khung tác vụ 
Thanh công cụ Standard và Formatting  Các thanh công cụ thường sử dụng. 
Views bar Thanh chuyển đổi chế độ views.  
 

Bài học thực hành đầu tiên. 

Tạo trang chủ 

Trang chủ là cánh cuả để đi vào web site cuả bạn. Nó chưá thông tin về nội dung và các vấn 
đề người đọc có thể quan tâm. Trên trang chủ thường có chưá các liên kết đến các trang 
khác. 
 

1. Trên trang trắng trong chế độ view Page, nhập Welcome to Championzone! và 
nhấn ENTER. 

 
Giống như trong Word nhấn enter có nghĩa là xuống hàng. 

 
2. Kế tiếp nhập đoạn sau Take a look around to learn more about our sporting 

goods, see pictures của our merchandise, and look at our Sports Photo Gallery. 
 

3. Nhấn ENTER. 
 

Giả sử nội dung cuả Web site đã được chuẩn bị sẵn, bạn có thể đưa các tài liệu đã 
có vào trong các trang Web mà không cần phải gõ lại 

 
 

 
 

Kế tiếp ta sẽ đưa một ảnh vào trong trang Web. Ảnh có thể  được quét vào bởi máy scanner 
hoặc những hình vẽ do các chương trình xử lý đồ họa tạo ra. 
Trong ví dụ này ta sẽ nhập vào hình sau: 
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Thực hiện chèn hình vào trang chủ. 

1. Vào menu Insert, chọn Picture, và bấm From File. 
 

FrontPage hiển thị ra hộp thoại Picture. 
 

2. Kế hộp Look In, Chọn ổ đĩa và thư mục chứa hình (chú ý chọn thư mục đã chép vào 
đĩa cứng) 

 
3. Chọn tệp hình có tên frontpage, bấm nút Insert. 
 
4. Nhấn ENTER đề xuống hàng. 

 
 

 
 
Nếu ta chỉ chèn hình và chữ vào trang chủ thì người dùng không thề di chuyển đến các trang 
khác. Muốn tạo ra các đồi tượng có thể bấm chuột vào được, ta phải gán các liên kết vào các 
đối tượng đó. 
 
Một liên kết là một địa chỉ cuả một trang khác ở trong phạm vi Web site hoặc trên Internet. 
Tạo ra một liên kết có nghiã là cho phép người dùng di chuyển đến một trang khác bằng cách 
bấm chuột. 
 

Tạo liên kết từ hình ảnh.  

1. Trên trang chủ, bấm chọn hình mới thêm vào. 
 
2. Vào menu Insert, chọn Hyperlink ( hoặc bấm Ctrl+K). 
 

FrontPage hiển thị hộp thoại Insert Hyperlink. Trong hộp thoaị này ta sẽ đưa vào 
đích cuả liên kết. 

 
3. Trong hộp Address, nhập www.microsoft.com/frontpage. 
 

Chú ý 
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o Frontpage sẽ tự động thêm tiếp đầu ngữ http. HTTP  là tên tắt cuả  Hypertext 
Transfer Protocol. Đây chính là một giao thức Internet để cho các trình duyệt 
có thể truy xuất thông tin từ Web server. 

 
o TRong ví dụ trên khi người dùng bấm vào hình họ sẽ được chuyển đến trang 

chủ cuả Microsoft FrontPage. 
 
4. Chọn OK để kết thúc tạo liên kết.  

 
Kế tiếp ta sẽ học cách đưa logo vào đấu trang chủ. 
 
Chèn hình vào trang chủ  

 
1. Nhấn CTRL+HOME  để trở về đấu trang. 

 
2. Trong menu Insert, Chọn Picture, và chọn From File. 
 
3. Nhấp đúp vào tên tệp czlogo. 
 

FrontPage sẽ chèn hình vào vị trí hiện hành. 
 

4. Nhấn ENTER  để đưa dòng tiêu đề xuống hàng. 
 
 

 
 
Đế kết thúc taọ trang chủ chúng ta sẽ canh giữa văn bản và hình ảnh. 

Canh giữa các thành phần trên một trang 

1. Vào menu Edit, chọn Select All. 
2. Vào menu Format, chọn Paragraph. 
3. Trong danh sách Alignment, chọn Center, sau đó nhấn OK. 
4. Bấm taị bất kỳ vị trí nào trên trang để thối chọn. 

Lưu trang hiện hành 

1. Vào menu File, chọn Save As. 
Trong hộp thoại Save As, chọn My Documents trong cây thư mục. 

2. Kế hộp Page title, bấm nút Change title . 
3. Trong hộp Set Page title, gõ Home Page và bấm OK. 
4. Trong hộp File name, gõ homepage, và bấm Save. 
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Các tùy chọn cuả Page View 

Hiển thị các thẻ HTML trên trang hiện hành. 

• Trong Page view  , chọn Reveal Tags trong menu View 
 

• FrontPage hiển thị cách biểu diễn các thẻ HTML . Điều này có ích nếu người sử dụng 
biết về HTML. 

 
• Để che giấu các thẻ, bấm Reveal Tags trên menu  View một lần nữa. 

 

Hiển thị mã nguồn  HTML của  trang hiện hành 

 
• Trong Page view, bấm chọn nút HTML tại đáy trang. 

 
Chế độ này dành cho những nhà thiết kế đã quen với mã HTML và có thể chỉnh sửa 
code để thay đổi thiết kế. 

 
• Chọn nút Normal tại đáy trang để trở về  khung Normal. 

 

 Tip   Khi làm việc trong  khung HTML , bạn vẫn có thể sử dụng các lệnh menu và thanh 
công cụ giống như trong khung Normal. 

 

Chế độ xem trước trang Web (preview) 

 
• Chọn Preview để có thể xem trước trang Web . 

 
Chú ý : Bạn cần có Microsoft Internet Explorer để có thể dùng chức năng này. 
Xem trước trang Web là một cách nhanh chóng để hình dung kết quả thiết kế sẽ đến 
với người đọc như thế nào. 

 
• Bấm nút Normal tại đáy trang để trở về  khung Normal một lần nữa. 

Tạo Web site với FrontPage 

Một Web site là một tập hợp các trang Web, hình ảnh, tư liệu, multimedia, và các file khác. 
Web site được lưu trữ trên web server hoặc trên ổ đĩa nội bộ cuả máy tính. 
Trong bài học thực hành đầu tiên, chúng ta đã thấy taọ trang Web với FrontPage  thật là dễ 
dàng, rất giống với cách taọ một văn bản trong Word. Điều khác biệt ở dậy là các liên kết. 
Công việc thiết kế trang Web ngoài phần tạo nội dung hình ảnh thi phần duy trì các liên kết là 
không kém phần quan trọng 

Thực hành tạo một web site mới.  

 
1. Vào menu File, chọn Close để đóng các trang hiện hành. 
2. Vào menu File, chọn mục New, và chọn Page or Web. 

 
FrontPage sẽ hiển thị khung tác vụ New Page or Web. Bạn có thể chọn nhiều mẫu 
Web site đã được thiết kế sẵn. 

 
3. Ở dưới  New from template, chọn Web Site Templates. 
 
4. Chọn One Page Web, bấm OK và nhấn TAB. 
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Khi bạn nhấn phím Tab, con trỏ sẽ nhảy đến các hộp tên và vị trí cuả Web site mới. 

5. Trong hộp Specify  location của  new Web,  nhập tên <drive>:\My Documents\My 
Webs\Championzone, và bấm OK. 

 
Chú ý 

• <drive> là ổ đĩa logic, thường là C:\ hoặc D:\. 
 
• FrontPage tạo một Web site mới có tên là “Championzone,” và hiển thị tên đó ở trên 

thanh tiêu đế. 
 
• Do chúng ta sẽ làm việc với nhiều tập tin trong Web site, FrontPage cũng hiển thị 

Folder List, tương tự như Windows Explorer.  
6. Nếu Folder List không hiển thị  ta lam như sau: 

• Trên thanh công cụ standard, bấm vào mũi tên bên cạnh Toggle Pane , sau 
đó chọn Folder List. 

7. Chọn biểu tượng Navigation   trên thanh Views . 
 

Navigation view sẽ hiển thị cấu trúc dạng cây cuả Web site. Khi chúng ta taọ ra một 

Web site một trang thì đó chính là trang chủ, có biểu tượng . 
 
Thanh công cụ Navigation : 
 

 
 
Sau đây ta sẽ tạo ra cấu trúc cuả web site dưạ vào Navigation view.   

Tạo cấu trúc Web Site. 

1. Trong chế độ Navigation view, bấm New Page  trên thanh công cụ. standard. 
FrontPage taọ ra một trang mới “New Page 1” ở dưới trang chủ. Chú ý đó chỉ là những 
con trỏ chỉ tới những trang web thực mà ta sẽ taọ ra sau này. 

2. Đề nhanh chóng taọ ra các trang còn lại nhấn CTRL + N 3 lần. 
CTRL+N là phím tắt cuả lệnh tạo trang mới. 
Chú ý:   Trong Navigation view, các trang dang dược chọn có màu xanh, các trang khác 
thì màu vàng. 

3. Giả sử đang chọn trang chủ, nhấn TAB. 
Mỗi lần nhấn Tab, con trỏ sẽ nhảy tới trang kế tiếp trong cấu trúc cây. Ta có thể thay đối 
tên cuả trang Web trong các hộp tên tương ứng. 

4. Nhập About Us, và nhấn TAB. 
About Us là tiêu đề trang để tự giới thiệu Web site Championzone. 

5. Lập lại các bước trên cho các trang khác, đổi tên New Page 2 thành Products, New 
Page 3 thành Photo Gallery, và New Page 4 thành Links. 

6. Nhấn ENTER sau khi đồi tên. 
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Để hiệu chỉnh nội dung cuả một trang ta có thể bấm đúp vào tên trang trong Navigation view. 
Bây giờ ta sẽ thay thế trang chủ bằng trang đã được tạo ra trong bài học đấu tiên. 

Nhập một trang Web vào Web site 

1. Trong Navigation view, Nhấp đúp vào index.htm  để mở ra. 
2. Vào menu Insert, chọn File. 
3. Trong hộp thoaị Select File, di chuyển đến thư mục My Documents . 
4. Bấm chọn tập tin homepage, bấm Open. 

 

5. Bấm nút lưu trên thanh công cụ standard. 
 

FrontPage  hiển thị hộp thoại  Save Embedded Files. Ở dây ta có thể xem trước, 
đổi tên, cấp nhật các tập tin được nhúng vào trang hiện hành. 

6. Trong hộp Save Embedded Files, chọn OK. 

Tạo nội dung Web site  

Hiệu chỉnh trang About Us.  

1. Chọn biểu tượng Navigation trong thanh Views để trở về chế độ Navigation view. 
2. Nhấp đúp  vào trang About Us  đề mở trang đó trong Page view. 

Trang này sẽ phải chứa các nội dung để giới thiệu công ty hoặc tổ chức cuả bạn 
với đọc giả cuả trang Web. Nếu nội dung đã được chuẩn bị sẵn, ta có thể sử dụng 
lệnh Insert file để đưa vào trong trang. 

3. Trên thanh công cụ standard, bấm Save  để lưu các thay đồi cuả trang About 
Us. 

4. Đóng cây thư mục Folder List. 
 
Kế tiếp chúng ta sẽ chuẩn bị hiệu chỉnh trang Products. Trang này có mục đích giới 
thiệu với khách hàng các sản phẩm và dịch vụ cuả công ty. Đồng thời trên trang này, 
chúng ta cũng tạo một phiếu phản hồi ý kiến (feedback form) để thu thập ý kiến khách 
hàng. 

Hiệu chỉnh trang Products 

1. Trên thanh công cụ standard, bấm Toggle Pane , rồi chọn Folder List. 
2. Nhấp đúp Products.htm trong Folder List để mở trang trong chế độ  Page view. 
3. Thôi hiển thị Folder List. 
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4. Vào menu Insert,  chọn File. 
Tương tự như trên ta có thể nhập vào một tệp bất kỳ chứa sẵn nội dung cần đưa 
vào trong tráng. 

5. Bấm nút Save.  

Thiết kế trang. 

Trang About Us  sẽ thừa hưởng các định dạng từ  chủ đề định dạng (theme) mà ta sẽ học 
trong chương 2. Tuy nhiên trang Products  cần thêm một số các thiết kế khác. 

Tạo danh sách đánh dấu.  

1. Với trang Products đang được mở tìm từ “Team Bag.” 
2. Chọn danh sách, kết thúc với “Goal Netting.” 

3. Trên thanh công cụ, chọn biểu tượng Bullets  . 
 

Trang của bạn sẽ có dạng sau : 
 

 
 

Định vị hình ảnh. 

1. Trang  Products còn đang hiển thị trong Page view, đặt điểm nháy sau “Featured 
Items của  Week.” 

2. Chọn biểu tượng Insert Picture From File  trên thanh tác vụ  
 
3. Chọn tên file FPTutor001, và sau đó bấm Insert. 
 

FrontPage chèn một picture của bóng đá ngay sau chữ “Featured Items của  Week.” 
 
5. Tiếp theo bấm vào hình và chọn nó.  
 
6. Trong menu Format, chọn Position. 
 

FrontPage hiển thị  hộp thoại Position. 
 
7. Trong phần Wrapping style, chọn Right,  và sau đó bấm OK. 
 
8. Bấm nút  Save trên thanh tác vụ để lưu các thay đổi cuả trang Products. 
 
9. Trong hộp thoại  Save Embedded Files ,  chọn bấm OK. 
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Trang của bạn sẽ có dạng sau : 

 

 
 

Thêm các tập tin vào Web site 

1. Chọn biểu tượng Folders   trên thanh tác vụ để chuyền về chế độ Folders view. 
 
2. Vào menu File , chọn Import. 
 

FrontPage hiển thị hộp thoại Import . Tại đây bạn có thể thêm tập tin, thư mục từ máy 
tính cục bộ hay từ mạng, từ máy chủ nội bộ hay từ INternet. 

 
3. Trên hộp thoại  Import  bấm  chọn Add File. 
 
4.  Trong hộp thoại  Add File to Import List, chuyển tới thư mục tên FPTutor2002. (thư 

mục đi kèm giáo trình, chép vào đĩa cứng của bạn) 
 

5. Kế tiếp, bấm  Files of type list, và sau đó bấm GIF and JPEG (*.gif, *.jpg) 
 
6. Bấm chọn czbanner trong danh sách. 
 
7. Kế tiếp, giữ CTRL, và bấm chọn các file FPTutor002, FPTutor003, FPTutor004, 

FPTutor005, và FPTutor006. 
 

8. Trong hộp thoại Add File to Import List , thả phím CTRL, và sau đó bấm Open. 
 

9. Bấm OK . 
 

Kết thúc định dạng trang. 

1. Trở về Page view. 
 
2. Đóng Folder List  

 
3. Trên trang Products , đặt điểm nháy sau câu : “PRODUCTS - SELECT FROM A 

HUGE RANGE OF GEAR” và sau đó bấm  Insert Picture From File trên  thanh công 
cụ. 

 
3. Trong hộp thoại  Picture chọn  file FPTutor002 từ danh sách. 
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Ta cũng có thể chèn từ Clipart, hoặc nếu bạn có scanner hay máy ảnh số, bạn có thể 
lấy từ nguồn đó ra . 

 
4. Bấm OK để chèn hình 

4. Bấm chọn hình, và sau đó bấm Align Right  trên  thanh công cụ để đưa hình về lề 
phải và làm cho chữ bao quanh. 

 
Trang của bạn sẽ có dạng sau : 
 

 
 

Tạo triển lãm ảnh (Photo Gallery). 

Bản chất cuả World Wide Web là một giao diện đồ họa, do đó việc sử dụng hình ảnh trên các 
trang Web là một công việc phổ biến và thịnh hành. Nhiều Web site có nhu cầu đưa lên một 
số lượng lớn các ảnh được sắp xếp theo những chủ đề nhất định và theo những định dạng 
nhất quán, chúng ta gọi đó là những phòng triển lãm ảnh trên Internet. 

Hiệu chỉnh trang Photo Gallery 

1. Cho hiển thị Folder List. 
2. Bấm đúp photo_gallery.htm.  
3. Thôi hiển thị Folder List. 
4. Khi trang trắng hiện ra, nhập Sports Photos rối nhấn ENTER. 
5. Trên dòng kế tiếp, gõ: Please enjoy our Sports Photo Gallery. Click each thumbnail 

to see  full-size picture. 
6. Nhấn ENTER 2 lần để taọ ra các khoảng trắng. 
7. Vào menu Insert, chọn Web Component. 
8. Ở khung bên trái bấm chọn Photo Gallery. 
9. Ở khung bên phải chọn kiểu trình bày. Bấm Finish. 
10. Hộp thoaị Photo Gallery Properties xuất hiện. 
11. Bấm Add, và bấm Pictures from Files. 
12. Dùng phím Shift để chọn nhiều ảnh liên tiếp trong danh sách tập tin. 
13. Bấm Open, và bấm OK. 
14. Trên thanh công cụ standard, bấm nút Save. 
15. Trong hộp thoại Save Embedded Files bấm OK. 
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Liên kết đến các Web Sites khác. 

Khi thiết kế một web site, ta luôn phải chú ý giúp người xem có thể tìm đến những thông tin 
liên quan từ các web site khác bằng cách tạo ra các liên kết. 

Tạo trang liên kết 

1.  Trên thanh công cụ, bấm nút mũi tên tại , sau đó bấm Folder List. 
 
2. Bấm đúp links.htm trong Folder List để mở trang. 
 
3. Gõ một vài dòng giới thiêu trang liên kết.Ví dụ : Liên kết đến các trang thể thao khác 
 

Kế tiếp, chúng ta sẽ tạo một chuyển động chữ đơn giản để tạo thêm sức hấp dẫn người đọc. 

Tạo hiệu ứng chuyển động văn bản 

1. Trên trang Links , bấm tại dòng Liên kết đến các trang thể thao khác. 
 

2. Trên menu Format, bấm HTML động Effects. 
 

FrontPage hiển thị  thanh công cụ DHTML Effects .  
HTML động là mở rộng của  ngôn ngữ HTML dùng để tạo ra những hiệu ứng trình diễn 
(presentation effect) giống như trong PowerPoint® slide show. Dùng thanh công cụ  
DHTML Effects bạn có thể thêm các hiệu ứng đơn giản cho các đối tượng mà không 
cần phải lập trình. 

 
3. Trong hộp On , bấm Page load. 

(báo cho trình duyệt biết hiệu ứng sẽ xảy ra khi nạp trang). 
 
4. Trong hộp Apply , bấm Hop. 

Đây là hiệu ứng tạo chuyển động phản xạ khi gặp cạnh. 
 

5. Bấm hộp  Close  của  thanh công cụ DHTML Effects. 
 

Thanh công cụ DHTML Effects đóng lại và bao quanh dòng chữ là một đường viền 
màu xanh nhạt 

 

 Chú ý 
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• Bấm  Preview để xem thử tác dụng của hiệu ứng, bấm Normal để trở ề thiết kế 
• Để thay đổi hiệu ứng, trong khung Normal , chọn văn bản, bấm HTML Effects trên  

menu Format, sau đó chọn hiệu ứng khác. 
 

Tạo hyperlink cho văn bản 

1. Trên trang Links , nhấn phím DOWN ARROW , gõ MSN Sports và sau đó nhấn 
ENTER. 

 
2. Bấm và kéo chuột để chọn cụm từ trên. 
 
3. Trên menu Insert, bấm Hyperlink. 
 

FrontPage hiển thị   hộp thoại Insert Hyperlink .Tại đây, bạn chỉ định đích của 
hyperlink . 

 
3.  Trong hộp  URL gõ www.msnbc.com/msn/msnsports_front.asp, và sau đó bấm OK. 
 

CHú ý rằng FrontPage tự động thêm tiếp đầu ngữ HTTP . 
 

4.   Nhấn  DOWN ARROW để thôi chọn. Chữ MSN Sports đổi thành màu xanh và có gạch 
dưới 

Chèn một ký tự dặc biệt 

1. Đặt điểm nháy vào vị trí sau MSN  . 
 
2. Trên menu Insert, bấm Symbol. 
 

FrontPage hiển thị hộp thoại Symbol . 
 
3. Trong hộp thoại  Symbol dialog box, chọn ký tự  ® , bấm Insert, và sau đó bấm Close. 

 
Bây giờ ta sẽ học cách tạo liên kết tự động (automatic hyperlink). Cách này nhanh và dễ làm 
vì nó bỏ qua việc hiển thị hộp thoại Create Hyperlink . 
 

Tạo liên kết tự động 

1. Trên trang Links page, nhấn  DOWN ARROW , gõ www.sports.yahoo.com, và sau 
đó nhấn ENTER. 

 
Ngay sau khi bạn nhấn ENTER,  địa chỉ URL vừa gõ sẽ tự động chuyển thành màu 
xanh và bị gạch chân, chứng tỏ đó là một hyperlink. 
Chú ý   Yahoo! là một dịch vụ rất thông dụng trên Internet để tra cứu và tìm kiếm thông 
tin đủ loại. Địa chỉ trên đưa tới trang thể thao của  Yahoo . 

 
2. Dùng chuột, chọn URL vừa gõ. 
 
3.  Gõ Yahoo! để thay thế cụm từ trên.TUy nhiên, liên kết vẫn được duy trì. 

 
Kế tiếp, chúng ta sẽ học cách tạo liên kết bằng trình duyệt. Phương pháp này đảm bảo đích 
của liên kết là chính xác vì chúng ta sẽ thực sự thăm trang Web đang hiện lên trên trình 
duyệt. 
 
Chú ý.  Nếu bạn không có kết nối trực tuyến thì có thể bỏ qua các bước sau. 

Tạo một hyperlink trực tuyến 

1. Tạo một dòng mới 
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2. Gõ National Basketball Association và sau đó nhấn ENTER. 
 
3. Bấm và kéo  chuột trên cụm từ vừa rồi. 

4. Trên thanh công cụ, bấm  Hyperlink  . 
 

FrontPage hiển thị hộp thoại Insert Hyperlink . 

5. Trong hộp thoại Insert Hyperlink , bấm  Browse  Web  . 
 
6. Trong trình duyệt gõ http://www.nfa.com, và sau đó nhấn ENTER. 
 

Web browser hiển thị trang chủ của Liên đoàn bóng chày . 
 

7. Nhấn ALT+TAB để trở về hộp thoại Create Hyperlink . 
 
8. Bấm OK. 
9.   Trên thanh công cụ, bấm  Save  

 

 
 

Định dạng tiêu đề đoạn 

Áp đặt định dạng paragraph styles cho các cấp tiêu đề 

1. MỞ index.htm. 
 
2. Đặt điểm nháy trong hàng Welcome to Championzone. 

 
3. Bấm  Style list trên  thanh công cụ Formatting, đổi Normal thành Heading 3. 

 
 

4. FrontPage áp đặt style Heading 3 cho đoạn hiện hành 
 

5. Các heading styles trong  Style list dựa vào các chuẩn HTML . Heading cấp 1 là kiểu  
tiêu đề cao nhất trong các trang Web , còn heading cấp 6 là nhỏ nhất. 
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Note    Style list có thể chứa trong các tệp gọi là cascading style sheets (CSS), 
nhưng trong tài liệu này chúng ta chưa học tới CSS. 

 
6. Trên thanh công cụ, bấm  Save để lưu  trang chủ. 

 
7. Bấm chọn mở About_Us.htm. 

 
8. Bấm trong tiêu đề About Us . 

 
9. Bấm Style list trên  thanh công cụ, và sau đó bấm Heading 4. 

 
10. Trên thanh công cụ, bấm  Save để lưu trang About Us 

 

Sử dụng Format Painter để sao chép định dạng 

FrontPage cung cấp một công cụ tương tự như Word, gọi là Format Painter , dùng để sao 
chép định dạng của một ký tự hay một đoạn, sau đó áp đặt định dạng đó cho các đối tượng 
khác một cách nhanh chóng (cách sử dụng xin tham khảo tài liệu Word). 

Kết thúc áp đặt định dạng cho các tiêu đề 

 
1. Mở photo_gallery.htm. 
 
2. Bấm bất cứ đâu trong  heading Sports Photos . 
 
3. Bấm  Style list trên  thanh công cụ, và sau đó bấm Heading 4. 

 
4. Trên thanh công cụ, bấm  Save. 

 
5. Trên Window menu, bấm links.htm. 

 
6. Bấm bất cứ đâu trong  Links to Sports Sites. 

 
7. Bấm  Style list trên  thanh công cụ, và sau đó bấm Heading 4 

 
8. Trên thanh công cụ, bấm  Save. 
 

Tới đây ta đã hoàn thành chương 1. 
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Chương 2 : Xử lý nâng cao và xuất bản một Web site 
 

Tổng quan 

Mục đích của chương: 
 

• Tạo liên kết đến các trang khác trong Web site 
• Tạo lề chung và thanh di chuyển 
• Tạo và hiệu chỉnh theme 
• Xem và thử Web site 
• Tổ chức thư mục và tập tin 
• Xuất bản lên World Wide Web. 

Tăng cường các định dạng cho Web site 

Mở một Web site 

Trong menu File, chọn Recent Webs, và chọn Championzone  để mở lại trang web . 
Thanh tiêu đề trở thành Microsoft FrontPage – 
<drive>:\My Documents\My Webs\Championzone. 
 
Chú ý rằng trong chương 1, ta chưa tạo một liên kết nào giữa các trang của web site 

 

Taọ liên kết đến các trang khác 

1. Trên thanh công cụ, bấm  Toggle Pane , và sau đó bấm Folder List. 
 
2. Nhấp đúp chuột váo trang index.htm trong danh sách các trang đang xem trong  

Folder List  
 
4. Khi  trang chủ hiển thị trong Page view, nhấn CTRL+END để đưa con nháy về cuối 

trang chủ. 
 

5. Tìm trang About_Us.htm trong danh sách trong  Folder List. 
 

Bây giờ ta kéo About us về phía dưới của trang chủ. FrontPage sẽ tạo một hyperlink 
đến  About Us trên trang chủ. 

 
5. Bấm và giữ chuột trên About_Us.htm trong  Folder List, kéo thả vào trang chủ. 

FrontPage hiển thị  một liên kết đến trang About Us . 
 
6. Lập lại các bước 4 và 5 để tạo các liên kết khác đến Products.htm, Links.htm, và 

Photo_gallery.htm. Đặt các liên kết kế tiếp nhau. 
 
7. Nhấn  DOWN ARROW để thôi chọn hyperlink. 
 

Trang của bạn sẽ có dạng sau : 
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Dĩ nhiên là bạn có thể thực hiện như trên với các trang khác trong Web site, nhưng đó là một 
việc mất rất nhiều thời gian nếu có nhiều trang. Ngoài ra, nếu ta quyết định thêm hay xoá 
trang khỏi Web site, ta phải cập nhật lại các liên kết bằng cách thủ công như trên. 
 
FrontPage có một cách làm hay hơn để khởi tạo, quản lý và tự động cập nhật các liên kết 
trong toàn bột Web site. Bây giờ, bạn sẽ xoá đi các liên kết vừa tạo ở trên bằng chức năng 

Undo (bấm nút Undo  trên thanh công cụ nhiều lần cho tới khi trả về trạng thái ban đầu) 

Tạo Shared Borders và thanh di chuyển (Navigation Bar) 

Shared borders (biên dùng chung)  là các vùng trên trang Web được dùng để chứa các nội 
dung xuất hiện một cách ổn định trên tất cả các trang trong Web site.Các biên này chứa các 
banner , quảng cáo hoặc các nút di chuyển. Banner của trang có` thể là tiêu đề trang sinh ra 
khi tạo trang, còn thanh di chuyển là các hàng hoặc cột chứa các liên kết chính của Web site. 
FrontPage có thể tự động cập nhật shared borders và navigation bars, sao cho cấu trúc của 
Web site luôn luôn hoạt động tốt, ngay cả khi thêm, di chuyển, xoá trang. 

Tạo shared border của Web site 

1. Chuyển qua chế độ Navigation view. 
 
2. Tắt hiển thị Folder List trong chế độ làm việc này. 
 
3. Trong menu Format, chọn Shared Borders. 

 
FrontPage hiển thị hộp thoại  Shared Borders .Chú ý có 2 loại thanh di chuyển có thể 
gắn vào 

 
4.  Trong hộp thoại  Shared Borders , tạo các tuỳ chọn cho tất cả các trang. Chắc chắn 
rằng All pages đã được chọn. 
 
5. Đánh dấu Top và đánh dấu tiếp Include navigation buttons để chỉ định cho hiển thị 

trên đầu trang. 
 
6. Đánh dấu Left và đánh dấu tiếp Include navigation buttons để chỉ định cho hiển thị 

trên bìa trái trang. 
7. Bỏ trống Right và Bottom , và sau đó bấm OK. 

 
FrontPage tạo shared borders và thanh di chuyển mặc nhiên cho tất cả các trang. 

 
Sau đây, ta sẽ học cách sửa đổi hình thức của thanh di chuyển cho phù hợp. 
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Thử nghiệm hyperlink trên thanh liên kết 

1.  Trong chế độ Navigation view, Nhấp đúp chuột vào trang chủ Home Page 
(index.htm). 

 
2. Tắt hiển thị Folder List trong chế độ làm việc này. 
 
3. Giữ CTRL và sau đó bấm  hyperlink có tên About Us trên lề trái. 
 

FrontPage mở trang đích của liên kết. Trong trang About Us , shared borders và thanh 
di chuyển cũng đã được chèn thêm vào đó. Tuy nhiên, trên trang này, các liên kết chỉ 
tới các trang khác chỉ hiển thị trong lề trên (top). Đó là do FrontPage sử dụng cấu trúc 
site để xác định các cấp (level) của trang hiện hành. 

 
Mặc nhiên, shared border ở trên chỉ tới các trang cùng cấp, còn shared border bên trái 
chỉ tới các trang cấp dưới 

Hiệu chỉnh thanh liên kết (link bar) 

1. Mở trang index.htm. 
 

FrontPage mở lại trang chủ . 
 

2. Trong phần thân cuả trang chủ nhấp đúp chuột lên dòng chữ màu đỏ  Edit  
properties for this Link Bar to display hyperlinks here. 

 
Nhấp đúp chuột lên thanh liên kết để mở hộp thoại Link Bar Properties . 

 
3. Trong hộp  Link Bar Properties , bấm Child level, xoá các hộp kiểm tại Home page 

và Parent page, và sau đó bấm OK. 
 

FrontPage tạo một navigation bar đến tất cả các trang cấp dưới trang chủ. 
 

Trang của bạn sẽ có dạng sau : 
 

 
 

Chú ý rằng lề trái vẫn chứa các liên kết tương tự lề trên . Ta sẽ học cách sửa hình 
thức và liên kết của lề này. 

 
4. Trong lề trái của  trang chủ, bấm đúp navigation bar. 

 
5. Trong hộp Link Bar Properties, chọn Same level, đành dấu chọn Home page, và 

nhấn OK. 
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FrontPage hiển thị Edit  properties for this link bar to display hyperlinks here. . 
 
6. Để lưu trang chủ, Chọn  Save trong menu File . 
 

Trang của bạn sẽ có dạng sau : 
 

 
 

7. Vào menu Window , chọn About_Us.htm. 
 

8. FrontPage mở lại trang About Us . 
 

Chú ý rằng tất cả những thay đổi trên các thanh liên kết đề được tự động phản ánh ở 
trang này, cũng như trong các trang khác. 

 

Chủ đề định dạng (theme) 

Trong Web site của chúng ta, các hình ảnh, danh sách, form. shared border, thanh liên kết đã 
có đủ cả và tạo nên một sắc thái đa dạng. Tuy nhiên, để cho hình thức các trang trong cùng 
Web site được trình bày một cách nhất quán, Frontpage sử dụng khái niệm theme (tạm gọi là 
chủ đề định dạng hay mẫu định dạng), giúp nhà thiết kế tiết kiệm được rất nhiều thời gian. 
 
FrontPage 2002 có hơn 50 theme được thiết kế sẵn một cách chuyên nghiệp . Mỗi theme 
bao gồm các thành phần trang như : danh sách (list), font, ảnh nền, hình trang trí, thanh di 
chuyển,… làm cho hình thức của Web site thêm sống động và nhất quán. 
 

Để áp đặt theme đối với Web site 

1. Chọn Page tab của index.htm. 
 
2. Trong menu Format, chọn Theme. 
 

FrontPage hiển thị  hộp thoại Themes . Tại đây, bạn có thể chọn theme tuỳ thích. Mỗi 
lần bấm chọn tên theme, một hình mẫu hiện ra để bạn xem trước có ưng không trước 
khi quyết định chọn. 

 
4. Trong phần Apply theme to,để xác lập cho tất cả các trang được chọn, chắc chắn 

rằng bạn đã đánh dấu All pages. 
 
5. Trong phần cài đặt themes, chọn Blends. 
 
6. Bỏ chọn Active graphics, Chọn OK to để xác lập lại theme. 
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7. Chọn Yes để khẳng định xác lập theme. 
 

Trang của bạn sẽ có dạng sau : 
 

 
 
Như bạn thấy, áp đặt định dạng theo chủ đề đã làm thay đổi hoàn toàn hình thức của 
Website . Thật đáng ngạc nhiên. 

Hiệu chỉnh Theme 

Mặc dù tiêu đề trang (page banner) tương đối đẹp, nhưng có lẽ chưa phù hợp lắm với nội 
dung của web site. Chúng ta sẽ tạo một banner khác dựa vào việc sửa đổi theme đang chọn. 

1. Mở lại trang chủ 
 
2. Trên menu Format, bấm Theme. 
 

FrontPage hiển thị  hộp thoại Themes . . 
 
3. Trong hộp thoại Themes, đánh dấu All Pages . 
 
4. Kế tiếp, bấm Modify. 
 
5. Dưới câu hỏi What would you like to modify? bấm Graphics. 
 

FrontPage hiển thị hộp thoại Modify Theme . Tại đây bạn có thể thay đổi hình ảnh và 
các thành phần đồ hoạ khác . 

 
6. Trong Item list, bấm Banner. 
 
7. Trên thẻ Picture , bấm  Browse dưới tên file của hình. 
 

FrontPage hiển thị hộp thoại Open File và hiển thị hình ảnh trong Web site hiện tại. Vì 
các hình ảnh ta muốn dùng chưa phải là một thanh phần của web site, ta sẽ tìm trên 
cây thư mục. 

 
8. Chuyển tới thư mục tên FPTutor2002. 
 
9. Bấm đúp  file czbanner. 

FrontPage thay thế banner hiện tại bằng hình mới nhập 
 
10. Bấm OK trong  Modify Theme , và sau đó bấm OK trong  Themes . 
 
11. Chọn Yes để tái xác nhận. 

 224



Microsoft FrontPage 2002 

 
FrontPage hiển thị   hộp thoại Save Theme cùng với thông báo This theme is read-
only. Please enter a new theme title to save as:. 

 
12. Nhập Championzone làm tiêu đề của  theme đã sửa, và chọn OK. 
 
13. Chọn Yes để xác lập theme. 
 
14. Bấm Save trên menu  File . 
 

Trang của bạn sẽ có dạng sau : 
  

 
  

 Tip  Trong ví dụ này, ta chỉ thay đổi 1 hình đơn giản để minh hoạ việc sửa đổi 
theme. Bằng cách đó, ta có thể tạo ra các theme mới rất dễ dàng bằng những 
hình ảnh riêng của mình. 

 

Xem trước  Web site Championzone  

Xem trước Web site trong  Web browser 

1. Trong menu File , chọn Preview in Browser. 
 

FrontPage hiển thị  hộp thoại Preview in Browser để bạn lựa chọn một trình duyệt đã 
cài đặt trên máy (Trong WinXP, đã có sẵn IE6). Web site của bạn đã sẵn sàng được 
xem thử trên trình duyệt này 
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2. Bấm tại các liên kết để kiểm tra các đích của nó 
3. Trên trang Photo Gallery, bấm các hình thu nhỏ (thumbnail) để kiểm tra các liên kết tới 

hình thực. Dùng nút Back của trình duyệt để trở về Photo Gallery  
4. Đóng cửa sổ Web browser sau khi đã kiểm tra xong. 

Tổ chức file trong web site 

Bây giờ trong Web site đã chứa nhiều trang và tập tin, bạn sẽ dùng chế độ Folders view để 
quản lý chúng. Tương tự như Windows Explorer, Folders view cho phép thực hiện các thao 
tác quản lý tập tin và thư mục trong phạm vi Web site. Bạn có thể thêm, bớt, thay đổi, sắp 
xếp lại các tài nguyên mà không phá vỡ các liên kết và cấu trúc của nó. 

 
 
Trong các bước sau, chúng ta sẽ thực hành chuyển các tệp ảnh từ Championzone Web site 
vào thư mục  Images do FrontPage tạo ra như một thành phần của  Web site. 
 
Chú ý rằng nếu bạn dùng Explorer hay một trình quản lý file nào khác để thực hiện các thao 
tác về file, bạn có thể bẻ gẫy các liên kết trong trang Web 

Di chuyển các file hình ảnh vào thư mục  Images  

1. Trên Views bar, bấm  Folders . 
 

FrontPage chuyển qua chế độ  Folders view. 
 
2. Trong  Folder List khung, bấm  thư mục trên cùng  

<drive>:\My Documents\My Webs\Championzone. 
 
3. Trong khung Contents , bấm cột Type  
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Danh sách của các file bây giờ được nhóm theo loại (GIF, JPEG,..). 
 
4. Trong khung Contents, bấm file GIF đầu tiên (czbanner.gif) để chọn nó 
 
5. Giữ SHIFT, bấm  file GIF cuối cùng trong danh sách (frontpage.gif). 
 
7. Kéo thả (nút phải) vào thư mục Images trong  Folder List . 

 
8. Khi thư mục  images được chọn, thả chuột , bấm Move Here menu tắt.. 
 

FrontPage hiển thị hộp thoại Rename trong quá trình di chuyển.. 
 
9. Lặp lại các bước 4 và 5 cho các tệp JPG (FPTutor003.jpg ->FPTutor006.jpg). 
 
10. Trong khung Contents , bấm cột Name để sắp xếp lại theo tên 

Tạo thư mục ( folder) mới  

1.  Trong danh sách thư mục , chọn thư mục chưá thư mục cần tạo . 
 
2. Trong menu File , chọn  New và chọn tiếp Folder. 
 

FrontPage tạo một thư mục mới có tên tạm “new folder”. 
 
3. Gõ tên mới và nhấn ENTER. 
 
4. Trong cây thư mục, Nhấp phải chuột vào thư mục vừa tạo. 
 
5. Trong menu shortcut, chọn Delete. 
 
6. Trong hộp Confirm Delete , chọn Yes. 
 

FrontPage xoá  folder khỏi  Web site. 

Xuất bản (publishing) Web site Championzone  

Khi xuất bản Web site lên INternet hoặc Intranet, FrontPage tự động kiểm tra các liên kết , 
các địa chỉ trang và đường dẫn của các địa chỉ đó. 

Xuất bản Web site đang làm việc 

1. Đóng tất cả các trang trong Page view. 
 

2. Trên menu File, bấm Publish Web, hoặc bấm nút Publish Web button  trên thanh 
công cụ..  
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3. Nhập địa chỉ URL của Web server , (ví dụ http://example.microsoft.com/~myweb), sau 

đó bấm Publish. 
 

 Tip   Sau khi xuất bản lần đầu, bạn có thể bỏ qua hộp thoại Publish Web bằng 
cách bấm nút Publish Web trên toolbar. 

 
Nếu FrontPage phát hiện bạn xuất bản lên một Web server không hỗ trợ FrontPage Server 
Extensions, nó liền chuyển qua chế độ file transfer protocol (FTP). 
 

 Tip   Khi xuất bản Web site, tất cả các trang và hình đều được tải lên mạng. Để loại trừ 
một số file không muốn xuất bản bấm Don’t Publish. 

 
Khi FrontPage xuất bản thành công, nó sẽ xuất hiện một hộp thoại chứa địa chỉ URL , qua đó 
có thể mở Web site trong trình duyệt Web để xem lại. 
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Đọc thêm 

Khái niệm và thuật ngữ   
 HTML là gì? Bookmark 
Dynamic HTML Web browser(Trình duyệt web) 
ActiveX Script
URL(Uniform Resource 
Locator) Structured Query Language - SQL

Website Hypertext Transfer Protocol-HTTP
Database Hyperlink
Hypertext HTTP address
World Wide Web - WWW Table
Internet Multimedia
Password File Transfer Protocol - FTP

HTML là gì? 

    HTML (hay Hypertext Markup Language-Ngôn ngữ liên kết siêu văn bản) là ngôn ngữ đánh dấu chuẩn 
dùng lập trình các tài liệu World Wide Web, tài liệu là các tập tin văn bản đơn giản. Ngôn ngữ  HTML  dùng 
các tag hoặc các đoạn mã lệnh để chỉ cho các trình duyệt(Web browsers) cách hiển thị các thành phần của 
trang như text và graghics ,và đáp lại những thao tác của người dùng bởi  các thao tác  ấn phím và nhắp 
chuột. Hầu hết các Web browser, đặc biệt là Microsoft Internet Explorer và Netscape Navigator, nhận biết các 
tag của HTML vượt xa những chuẩn HTML đặt ra. Microsoft FrontPage chỉ dùng để đọc và viết các tập tin  
HTML mà không hiểu ngôn ngữ HTML yêu cầu phải làm gì. 

Fronpage, InterDev    VBScript, JavaScript   Internet Explorer   
HTML Editor  -->  HTML  ------->  DHTML, ASP  -------->  (Web)WWW  
   Web tĩnh  SQL, Access, Oracle  Web động    

- Dynamic HTML(DHTML-HTML động): là ngôn ngữ HTML mở rộng làm tăng hiệu ứng trình bày văn bản và 
đối tượng khác. Trong FrontPage, bạn có thể sử dụng thanh công cụ DHTML Effects để làm tăng cường 
hiệu ứng cho các thành phần của mà không cần lập trình. 

- ActiveX: 1 tập hợp các kỹ thuật cho phép các thành phần phần mềm tương tác với một thành phần khác 
trong môi trường mạng, bất chấp ngôn ngữ của thành phần được tạo ra. ActiveX được dùng làm chính yếu 
để phát triển nội dung tương tác của World Wide Web, mặc dù nó có thể sử dụng trong các ứng dụng người-
máy và các chương trình khác. 

- URL(Uniform Resource Locator): địa chỉ tới một trạm Internet hay mạng nội bộ, là 1 chuỗi cung cấp địa 
chỉ Internet của 1 Web site tài nguyên trên World Wide Web, đi theo sau 1 nghi thức.  URL thường dùng là 
http://, để chỉ định địa chỉ Web site trên Internet. Những URL khác là gopher://, ftp://, mailto://...  

- Bookmark: 1 vị trí trên 1 trang web có thể là đích của 1 hyperlink. 1 bookmark có thể áp dụng cho 1 chuỗi 
ký tự tồn tại trên trang ngăn cách bởi bất kỳ ký tự nào. Bookmarks cho phép tác giả link đến 1 phần đã chỉ 
định trên trang. Trong 1 URL, 1 bookmark được đánh dấu phía trước bằng dấu thăng(#). Cũng được gọi là 
neo(anchor). 

- Web browser(Trình duyệt web): Phần mền phiên dịch đánh dấu của các file bằng  HTML, định dạng 
chúng sang các trang Web, và thể hiện chúng cho người dùng. Vài browser có thể cho phép người dùng gởi 
nhận e-mail, đọc newsgroups, và thực hiện các file sound hoặc video đã được nhúng và trong tài liệu Web. 
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- Script: Một tập các chỉ lệnh dùng để báo cho chương trình biết cách thực hiện một thủ tục qui định, như 
đang nhập vào hệ thống thư điện tử chẳng hạn. Các khả năng script được cài sẵn trong một số chương trình. 
Bạn phải tìm hiểu cách viết script đó bằng loại ngôn ngữ không khác gì ngôn ngữ lập trình mini. Có một số 
chương trình ghi script này một cách tự động bằng cách ghi lại những lần gõ phím và chọn dùng lệnh của 
bạnh khi bạn tiến hành thủ tục này. Các script giống như các macro, trừ một điều là thuật ngữ macro được 
dành riêng để chỉ những script nào mà bạn có thể khởi đầu bằng cách ấn một tổ hợp phím do bạn tự quy 
định.  

- Structured Query Language - SQL: Trong các hệ quản lý cơ sở dữ liệu, đây là ngôn ngữ vấn đáp do IBM 
soạn thảo được sử dụng rộng rãi trong máy tính lớn và hệ thống máy tính mini. SQL đang được trang bị 
trong các mạng khách/chủ như là một phương pháp làm cho các máy tính cá nhân có khả năng thâm nhập 
vào các tài nguyên của các cơ sở dữ liệu hợp tác. Ðây là loại ngôn ngữ độc lập với dữ liệu; người sử dụng 
không phải bận tâm đến vấn đề dữ liệu sẽ được thâm nhập vào bằng cách nào về mặt vật lý. Theo lý thuyết, 
SQL cũng độc lập với thiết bị; có thể dùng cùng một ngôn ngữ vấn đáp để thâm nhập vào các cơ sở dữ liệu 
trên máy tính lớn, máy tính mini, và máy tính cá nhân. Tuy nhiên, hiện nay có một số phiên bản của SQL 
đang bị cạnh tranh. SQL là một ngôn ngữ vấn đáp lịch sự và súc tích chỉ với 30 lệnh. Bốn lệnh cơ bản ( 
SELECT, UPDATE, DELETE, và INSERT) đáp ứng cho bốn chức năng xử lý dữ liệu cơ bản (phục hồi, cải 
tiến, xoá, và chèn vào). Các câu hỏi của SQL gần giống cấu trúc của một câu hỏi tiếng Anh tự nhiên. Kết quả 
của câu hỏi sẽ được biểu hiện trong một bản dữ liệu bao gồm các cột (tương ứng với các trường dữ liệu) và 
các hàng (tương ứng với các bản ghi dữ liệu).  

- Hypertext Transfer Protocol-HTTP: Giao thức truyền siêu văn bản 

- Hyperlink: Siêu liên kết 

- Web site: chỗ web. 

- HTTP address: địa chỉ HTTP, ví dụ http://www.microsoft.com 

- Database: cơ sở dữ liệu, kho dữ liệu. Một bộ sưu tập các thông tin về một chủ đề, được tổ chức hợp lý để 
thành một cơ sở cho các thủ tục công việc như truy tìm thông tin, rút ra các kết luận, và thành lập các quyết 
định. Bất kỳ một sưu tập thông tin nào phục vụ cho các mục đích này đều được coi là một cơ sở dữ liệu, 
ngay cả trường hợp các thông tin đó không được lưu trữ trong máy tính. Thực ra, "tổ tiên" của các hệ cơ sở 
dữ liệu doanh thương phức tạp hiện nay là những tệp được giữ trên các tấm bìa, có mang mã số, và được 
xếp trong các phòng lưu trữ trước đây. Thông tin thường được chia ra thành nhiều bản ghi ( record) dữ liệu 
khác nhau, trên đó có một hay nhiều trường dữ liệu. Ví dụ bản ghi về phim thiếu nhi của một cửa hàng video 
có thể gồm có các thông tin như sau: TITLE The Blue Fountain CATEGORY Children RATING G RETAIL 
PRICE 24. 9 đ RENTED TO 325 - 1234 DUE DATE 12 / 3 / 92. 

- Table: bảng Trong chương trình quản lý cơ sở dữ liệu liên quan, đây là cấu trúc cơ sở của việc lưu trữ và 
hiển thị dữ liệu, trong đó các khoản mục dữ liệu được liên kết với nhau bởi các quan hệ hình thành do việc 
đặt chúng theo các hàng và các cột. Các hàng ứng với các bản ghi dữ liệu của các chương trình quản lý dữ 
liệu hướng bảng, và các cột thì ứng với các trường dữ liệu. Trong chương trình xử lý từ, thường có thể dùng 
lệnh Table để tạo ra một bảng tính gồm các cột và các hàng có khản năng tính toán. Trong chương trình xử 
lý, thường có thể dùng lệnh Table để tạo ra một bảng tính gồm các cột và các hàng có khả năng tính toán. 
Trong một vài chương trình xử lý từ, tài liệu dữ liệu được tạo ra bằng tính năng hòa hợp thư sẽ tổ chức dữ 
liệu hòa hợp đó trong một bảng. 

- Hypertext: văn bản của một tài liệu truy tìm không theo tuần tự. Người đọc tự do đuổi theo các dấu vết liên 
quan qua suốt tài liệu đó bằng các mối liên kết xác định sẵn do người sử dụng tự lập nên. 
Trong một môi trường ứng dụng hypertext thực sự, bạn có thể trỏ vào ( highlight) bất kỳ từ nào của tài liệu và 
sẽ tức khắc nhảy đến các tài liệu khác có văn bản liên quan đến nó. Cũng có những lệnh cho phép bạn tự 
tạo cho riêng mình những dấu vết kết hợp qua suốt tài liệu. Các trình ứng dụng hypertext rất hữu ích trong 
trường hợp phải làm với một số lượng văn bản lớn, như các bộ từ điển bách khoa và các bộ sách nhiều tập. 

- Multimedia: đa phương tiện, đa môi trường, đa truyền thông 
Một phương pháp giới thiệu thông tin bằng máy tính, sử dụng nhiều phương tiện truyền thông tin như văn 
bản, đồ hoạ và âm thanh, cùng với sự gây ấn tượng bằng tương tác. 
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Trong chương trình giới thiệu đa phương tiện gọi là beethoven windowss World ( Thế giới Beethoven) chẳng 
hạn, bạn có thể nhìn thấy chân dung của nhà soạn nhạc, nghe âm nhạc của ông, và cả những đoạn văn bản 
về cuộc sống riêng của nhạc sĩ. Những tiến bộ đạt được trong việc đồng bộ âm thanh và video cho phép bạn 
có thể hiển thị các hình video động trong những cửa sổ màn hình. 

- World Wide Web - WWW: Trong các máy tính có cơ sở UNIX và được nối với mạng Internet. Ðây là một 
hệ thống dùng để truy tìm và phục hồi các tài liệu hypertext thực hiện. Ðược xây dựng đầu tiên ở một phòng 
thí nghiệm vật lý, WWW thường xuyên nhận được các thông tin bổ sung nhờ những người sử dụng đóng 
góp thêm các tài liệu đã được đánh chỉ số. 
Khi nhìn vào một trình đơn Web, bạn nhìn thấy một số các khoản mục được gạch dưới (trên các màn hình đồ 
họa) hoặc được đánh số thứ tự (trên các màn hình ký tự) đó là các mối liên kết sẽ hiển thị một tài liệu liên 
quan khi làm cho chúng hoạt động bằng một lệnh thích hợp. 

- File Transfer Protocol - FTP: định ước truyền tệp, giao thức truyền tệp. Trong truyền thông không đồng 
bộ, đây là một tiêu chuẩn nhằm bảo đảm truyền dẫn không bị lỗi cho các tệp chương trình và dữ liệu thông 
qua hệ thống điện thoại. Chương trình FTP cũng được dùng để gọi tên cho định ước truyền tệp UNIX, một 
định ước hướng dẫn việc truyền dữ liệu. 

- Internet: Một hệ thống gồm các mạng máy tính được liên kết với nhau trên phạm vi toàn thế giới, tạo điều 
kiện thuận lợi cho các dịch vụ truyền thông dữ liệu, như đăng nhập từ xa, truyền các tệp tin, thư tín điện tử, 
và các nhóm thông tin. 

Internet là một phương pháp ghép nối các mạng máy tính hiện hành, phát triển một cách rộng rãi tầm hoạt 
động của từng hệ thống thành viên. 

Nguồn gốc đầu tiên của Internet là hệ thống máy tính cuả Bộ Quốc Phòng Mỹ, gọi là mạng ARPAnet, một 
mạng thí nghiệm được thiết kế từ năm 1969 để tạo điều kiện thuận lợi cho việc hợp tác khoa học trong các 
công trình nghiên cứu quốc phòng. 

ARPAnet đã nêu cao triết lý truyền thông bình đẳng ( peer-to-peer), trong đó mỗi máy tính của hệ thống đều 
có khả năng "nói chuyện" với bất kỳ máy tính thành viên nào khác. 
Bất kỳ mạng máy tính nào dựa trên cơ sở thiết kế của ARPAnet đều được mô tả như một tập hợp các trung 
tâm điện toán tự quản, mang tính địa phương và tự điều hành, chúng được liên kết dưới dạng "vô chính phủ 
nhưng có điều tiết" . 

Sự phát triển thiết kế của mạng ARPAnet đơn thuần chỉ do những yêu cầu về quân sự: 
Mạng này phải có khả năng chống lại một cuộc tấn công có thể vô hiệu hoá một số lớn các trạm thành viên 
của nó. 

Tư tưởng này đã được chứng minh là đúng khi Mỹ và các đồng minh tham gia vào cuộc chiến tranh vùng 
Vịnh. 

Sự chỉ huy và mạng kiểm soát của Irak, được tổ chức mô phỏng theo công nghệ ARPAnet, đã chống lại một 
cách thành công đối với các nổ lực của lực lượng đồng minh nhằm tiêu diệt nó. 
Ðó là lý do tại sao công nghệ có nguồn gốc từ ARPAnet hiện nay đang được xuất cảng một cách rộng rãi. 

Mạng Internet nguyên thuỷ được thiết kế nhằm mục đích phục vụ việc cung cấp thông tin cho giới khoa học, 
nên công nghệ của nó cho phép mọi hệ thống đều có thể liên kết với nó thông qua một cổng điện tử. 

Theo cách đó, có hàng ngàn hệ máy tính hợp tác, cũng như nhiều hệ thống dịch vụ thư điện tử có thu phí, 
như MCI và Compuserve chẳng hạn, đã trở nên thành viên của Internet. 
Với hơn hai triệu máy chủ phục vụ chừng 20 triệu người dùng, mạng Internet đang phát triển với tốc độ bùng 
nổ, mỗi tháng có thêm khoảng một triệu người tham gia mới. 

- Password: mật khẩu, mật lệnh Một công cụ bảo vệ an toàn, dùng để xác định đúng người sử dụng được 
phép đối với một chương trình máy tính hoặc mạng máy tính, và để xác định các phạm vi quyền hạn của họ 
như chỉ đọc ra, được đọc và ghi, hoặc được sao chép các tệp 

  231 



Microsoft FrontPage 2002 
Đọc thêm 

NGÔN NGỮ HTML DÙNG ĐỂ SOẠN THẢO TRANG WEB 
   

Cấu trúc trang web 
Cú pháp tag tổng quát  
Tag đầu trang: <HTML></HTML>  
Tag bắt đầu: <HEAD></HEAD>  
Tag tiêu đề: <TITLE></TITLE>  
Tag thân trang: <BODY></BODY>  
Tag định dạng font chữ: <FONT></FONT>,<BASEFONT></BASEFONT>  
Tag xuống dòng sang đoạn mới: <P></P>  
Tag xuống dòng không sang đoạn mới: <BR></BR>  
Tag thêm đường thẳng nằm ngang: <HR></HR>  
Tag 6 mức tiêu đề: <hN></hN>  
Tag đậm: <B></B>  
Tag nghiêng: <I></I>  
Tag gạch dưới: <U></U>  
Tag gạch giữa: <S></S>  
Tag đậm logic type: <STRONG></STRONG>  
Tag nghiêng logic type: <EM></EM>  
Tag gạch ngang logic type: <STRIKE></STRIKE>  
Tag chỉ số logic type: <SUB></SUB>  
Tag mũ logic type: <SUP></SUP>  
Tag nhạc nền: <BGSOUND></BGSOUND>  
Tag hình ảnh, phim: <IMG></IMG>  
Tag danh sách <UL><LI></UL>, <OL><LI></OL>  
Tag định dạng bảng <TABLE><TR><TD></TABLE>  
Tag tạo Frame <FRAMESET><FRAME></FRAMESET>  
Bảng ký tự thay thế thể hiện trong file nguồn HTML  
Tag liên kết đến 1 đoạn chỉ định trong tư liệu hiện hành hoặc một trang web khác <A></A>.  
-------------- 
Cấu trúc trang web  
<HTML>  
<HEAD>  
<TITLE>Tiêu đề trang web</TITLE>  
</HEAD>  
<BODY>  
Thân trang web  
</BODY>  
</HTML>  
--- 
Cú pháp tag tổng quát  
Khi trình duyệt (web browser) hiển thị nội dung 1 trang web nó sẽ tìm kiếm trong đó những đoạn mã đặc biệt 
là các tag được đánh dấu bởi ký hiệu <và>, và căn cứ vào đó để thể hiện. Cú pháp tổng quát của 1 tag:  
<tên_tag thuộc_tính_2=giá_trị_1  thuộc_tính_2=giá_trị_2...>...</tên_tag>  
hoặc đơn giản nhất là: <tên_tag>Chuỗi văn bản</tên_tag>  
tên_tag gõ vào dạng chữ thường hoặc hoa đều được và các tag có thể lồng vào nhau.  
Ví dụ:  
    - tag chữ đậm <B> cú pháp <B>chuỗi văn bản in đậm</B>  
    - tag xuống hàng <P> có cú pháp <P ALIGN=align-type>một đoạn văn bản</P>  
HTML  Kết quả  

Dòng chữ này thường  Dòng chữ này thường  

<b>Dòng chữ này đậm</b>  Dòng chữ này đậm  

<i>Dòng chữ này nghiêng</i>  Dòng chữ này nghiêng  
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<font color="#800000" face="Verdana">Ðây là đoạn văn thứ nhất 
màu đỏ có phông là Verdana.</font><p><font color="Black" 
face="Verdana">Ðây là đoạn văn thứ hai màu ô liu có phông cũng 
là Verdana.</font></p>  

Ðây là đoạn văn thứ nhất màu đỏ có 
phông là Verdana.  
Ðây là đoạn văn thứ hai màu ôliu có 
phông cũng là Verdana.  

<b><i>Dòng chữ này vừa đậm vừa nghiêng</i></b>  Dòng chữ này vừa đậm vừa nghiêng  

Ðoạn này canh trái.</font><p align="center"><font 
face="Verdana">Ðoạn này canh giữa.</font></p><p 
align="right"><font face="Verdana">Ðoạn này canh phải.</font>  

Ðoạn này canh trái.  
Ðoạn này canh giữa.  
Ðoạn này canh phải.  

Tag đầu trang <HTML></HTML> :Tag <HTML> ở đầu trang web tĩnh và </HTML> ở cuối trang. Trang web 
được bắt đầu và kết thúc bởi tag này.  
Tag bắt đầu <HEAD></HEAD> :Tag <HEAD> đánh dấu điểm bắt đầu phần_đầu_heading của trang web. 
Tag </HEAD> có thể bỏ qua.  
Tag tiêu đề <TITLE></TITLE> :Tag <TITLE> chỉ định tiêu đề của của trang web. Tiêu đề này sẽ xuất hiện 
trên thanh tiêu đề của trình duyệt(web browser: Internet Explorer hoặc Netscape Navigator). Tag này chỉ hợp 
lệ khi đưa vào bên trong phần <HEAD>  
Ví dụ:  

HTML  Kết quả  
<html>  
<head>  
<title>Web demo</title>  
</head>  
<body>  
Hello World!  
</body>  
</html>  

- Trên thanh tiêu đề xuất hiện:  
Web demo - Microsoft Internet Explorer  
- Nội dung trang web xuất hiện:   
Hello World!  

-------------------------------------------------------------  
Tag thân trang <BODY></BODY>: dùng chỉ định bắt đầu và kết thúc phần nội dung trang web. Tag này 
được định nghĩa như sau:  
<BODY  
BACKGROUND=url  
BGCOLOR=color  
BGPROPERTIES=FIXED  
LEFTMARGIN=n  
LINK=color  
TEXT=color  
TOPMARGIN=n  
VLINK=color>  
trong đó:  

Thuộc tính  Diễn giải  

url  

Viết tắt của Uniform Resource Locators: là 1 chuỗi cung cấp địa chỉ Internet của 1 
Web site hoặc tài nguyên trên World Wide Web, theo cùng là nghi thức protocol 
của site hoặc tài nguyên truy cập vào. Nghi thức thường dùng http://, cho các địa 
chỉ Internet của một trang web. Vài  dạng URL khác là gopher://, cho các địa chỉ 
Internet của 1 thư mục dịch vụ gopher, và ftp://, cho các địa chỉ tài nguyên  FTP.  
Trong tag <BODY> ta thường dùng dạng URL là file://, tên tập tin ảnh .GIF, .JPG, 
.BMP. Khi lưu trang web, bạn sẽ xác định thư mục mới sẽ lưu trữ tập tin ảnh.  

color  
Màu dạng #NNNNNN với N:0,1,...,F. Hoặc tên những màu đã quy định trước như: 
AQUA, BLACK, Black, FUCHSIA, GRAY, GREEN, LIME, MAROON, NAVY, 
OLIVE, PURPLE, #800000, SILVER, TEAL, WHITE, YELLOW.  

BACKGROUND=url  Chỉ định ảnh nền cho trang web, url là địa chỉ và tên tập tin làm ảnh nền.  
BGCOLOR=color  Chỉ định màu nền cho trang web  
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BGPROPERTIES=FIXED Chỉ định ảnh nền trang web không cuộn khi cuộn thanh scrollbar.  
LEFTMARGIN=n  Chỉ định lề trái trang web, n là 1 số nguyên dương tính theo pixel  
LINK=color  Chỉ định màu cho các hyperlink khi chưa được "duyệt" trong trang web.  
TEXT=color  Chỉ định màu văn bản trong trang web  
TOPMARGIN=n  Chỉ định lề trên trang web, n là 1 số nguyên dương tính theo pixel  
VLINK=color  Chỉ định màu cho các hyperlink khi đã được "duyệt" trong trang web.  
Ví dụ:  

HTML  Kết quả  
<BODY BGCOLOR=YELLOW TEXT=#800000>  
Chào mừng thế kỷ mới  
</BODY>  

Chào mừng thế kỷ mới  

<BODY BGCOLOR="#0000FF" TEXT="#FFFFFF">  
Chào mừng thế kỷ mới  
</BODY>  

Chào mừng thế kỷ mới  

<html>  
<head>  
<title>Web demo</title>  
</head>  
<BODY text=BLACK background="images/so01871_1.gif" 
topmargin="20" leftmargin="25" link=#800000 vlink=GREEN>  
<p align="center"><b>Danh mục công việc</b><p><a href="#Nội dung 
mục 1">Mục  
1</a></p>  
<p><a href="#Nội dung mục 2">Mục 2</a></p>  
<p><a href="#Nội dung mục 3">Mục 3</a></p>  
<p></p>  
<p><a name="Nội dung mục 1">Nội dung mục 1</a></p>  
<p></p>  
<p></p>  
<p>&nbsp;</p>  
<p>&nbsp;</p>  
<p><a name="Nội dung mục 2">Nội dung mục 2</a></p>  
<p></p>  
<p></p>  
<p>&nbsp;</p>  
<p>&nbsp;</p>  
<p>&nbsp;</p>  
<p>&nbsp;</p>  
<p>&nbsp;</p>  
<p><a name="Nội dung mục 3">Nội dung mục 3</a></p>  
<p>&nbsp;</p>  
</BODY>  
</html>  

- file ảnh nền: so01871_1.gif  
- Vì không đưa vào thuộc tính 
bgproperties="fixed" nên ảnh nền bị 
cuộn  
- lề trái=25  
- lề trên=20  
- màu văn bản đen  
- màu hyperlink chưa duyệt là đỏ  
- màu hyperlink đã  duyệt là xanh   

Tag xuống dòng sang đoạn mới <P></P>: ngắt văn bản sang đoạn (paragraph) mới. Thành phần </P> 
cuối đoạn không nhất thiết phải có. Tag này được định nghĩa như sau: <P ALIGN=align-type>,  ALIGN=align-
type dùng chỉ định canh đoạn mới. align-type=LEFT(canh trái), RIGHT(canh phải) hoặc CENTER(canh giữa).  
Ví dụ:  

HTML  Kết quả  

Có 2 trình duyệt hiện đang được sử dụng rộng rãi là: <p 
align=left>- Netscape Navigator <p align=center>- Và Internet 
Explorer  

Có 2 trình duyệt hiện đang được sử dụng 
rộng rãi là:  
- Netscape Navigator  

- Và Internet Explorer  
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Tag xuống dòng không sang đoạn mới <BR></BR>: ngắt xuống dòng mới nhưng vẫn thuộc cùng một 
đoạn hiện hành.</BR> không nhất thiết phải có.   
Ví dụ:  

HTML  Kết quả  
Frontpage hay tự thêm vào các chuỗi mã thay thế cho 
việc đưa các ký tự vào source  trang web như:<BR>- 
chuỗi "&reg;" thay thế ký tự (R).<BR>- chuỗi "&lt;" 
thay thế dấu <.  

Frontpage hay tự thêm vào các chuỗi mã thay thế cho 
việc đưa các ký tự vào source  trang web như:  
- chuỗi "&reg;" thay thế ký tự (R).   
- chuỗi "&lt;" thay thế dấu <.  

  
Tag thêm đường thẳng nằm ngang <HR></HR>:  thêm đường thẳng nằm ngang trong trang web. Tag này 
được định nghĩa như sau:  
<HR  
ALIGN=align-type  
COLOR=color  
NOSHADE  
SIZE=n  
WIDTH=m>  
trong đó:  
 - ALIGN=align-tpye: canh lề cho đường thẳng ngang, align-type có thể là LEFT, RIGHT, CENTER  
 - COLOR=color: màu đường thẳng ngang  
- NOSHADE: không có bóng  
- SIZE=n : độ đậm của đường thẳng ngang, n có giá trị là số nguyên tính theo đơn vị pixel.  
Ví dụ:  

HTML  Kết quả  
<HR  
ALIGN=CENTER  
COLOR=#800000  
NOSHADE  
SIZE=3  
WIDTH=200>  
<HR  
ALIGN=LEFT  
COLOR=BLACK  
SIZE=2  
WIDTH=150>  
-----------------------------  
Tag đậm <B></B>: Hiển thị văn bản đậm theo physical type  
Tag nghiêng <I></I>: Hiển thị văn bản nghiêng theo physical type  
Tag gạch dưới <U></U>: Hiển thị văn bản gạch dưới theo physical type  
Tag gạch giữa <S></S>: Hiển thị văn bản gạch giữa(strikeout) theo physical type  
Ví dụ:  

HTML  Kết quả  
Dòng này thông thường  Dòng này thông thường  
<b>Dòng này đậm</b>  Dòng này đậm  
<i>Dòng này nghiêng</i>  Dòng này nghiêng  
<u>Dòng này gạch dưới</u>  Dòng này gạch dưới  
<s>Dòng này gạch giữa</s>  Dòng này gạch giữa  
<b><i>Dòng này vừa đậm vừa nghiêng</b></i>  Dòng này vừa đậm vừa nghiêng  
<i><u>Dòng này vừa nghiêng vừa gạch dưới</u></i> Dòng này vừa nghiêng vừa gạch dưới  
-------------------------------------------------------  
Tag đậm logic type <STRONG></STRONG>:Hiển thị văn bản đậm theo logic type  
Tag nghiêng logic type <EM></EM>: Hiển thị văn bản nghiêng theo logic type  
Tag gạch ngang logic type <STRIKE></STRIKE>: Hiển thị văn bản gạch dưới theo logic type  
Tag chỉ số logic type <SUB></SUB>: Hiển thị văn bản dạng chỉ số theo logic type  
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Tag mũ logic type <SUP></SUP>: Hiển thị văn bản dạng mũ theo logic type  
Ví dụ:  

HTML  Kết quả  
Dòng này thông thường  Dòng này thông thường  
<strong>Dòng này đậm</strong>  Dòng này đậm  
<em>Dòng này nghiêng</em>  Dòng này nghiêng  
<strike>Dòng này gạch giữa</strike>  Dòng này gạch giữa  
<strong><em>Dòng này vừa đậm vừa 
nghiêng</strong></em>  Dòng này vừa đậm vừa nghiêng  

<em><u>Dòng này vừa nghiêng vừa gạch 
dưới</u></em>  Dòng này vừa nghiêng vừa gạch dưới  

H<sub>2</sub>SO<sub>4</sub>  H2SO4  
x<sup>y</sup>  x

y  
 
Tag định font chữ cơ sở <BASEFONT></BASEFONT>:chỉ định font, size, màu văn bản cho các văn bản 
không định dạng và dùng với tag   
<BASEFONT  
    SIZE=n  
    FACE=name  
    COLOR=color>  
Trong đó:  
    SIZE=n: chỉ định kích thước văn bản, n từ 1 đến 7. Giá trị mặc nhiên là 3.  
    COLOR=color: màu văn bản  
    FACE=name: tên font  
Tag font chữ <FONT></FONT>: chỉ định font, size, màu văn bản. Ðịnh nghĩa như sau:  
<FONT  
    SIZE=n  
    FACE=name  
    COLOR=color>  
Trong đó:  
    SIZE=n: chỉ định kích thước văn bản, n từ 1 đến 7. Thêm dấu cộng + hoặc trừ - phía trước để chỉ định việc 
tăng hoặc giảm kích thước so với kích thước đã định trong BASEFONT.  
    COLOR=color: màu văn bản  
    FACE=name: tên font  
Ví dụ: Văn bản thường  

HTML  Kết quả  
<basefont size=3>  
<font size=5> Kích thước văn bản là 5</font>  
<p><font size=+1>Kích thước văn bản là 4</p></font>  
<p><font size=+2>Kích thước văn bản là 5</p></font>  
<p><font size=-1>Kích thước văn bản là 2</p></font>  

Kích thước văn bản là 5  
Kích thước văn bản là 4  
Kích thước văn bản là 5  
Kích thước văn bản là 2  

-------------- 
Tag nhạc nền <BGSOUND>: định nhạc nền cho trang tư liệu. Tag này được đặt dưới tag </HEAD> nhưng 
trên tag <BODY>. Ðịnh nghĩa như sau:  
<BGSOUND  
    SCR=url  
    LOOP=n>  
Trong đó:  
url: chỉ định tập tin nhạc. Các kiểu nhạc có thể là WAV, AU, MIDI.  
n: chỉ số lần lặp lại bài nhạc. Nếu n=-1 hoặc infinite thì sẽ lặp đến khi nào đóng trang web.  
Ví dụ:  
<HTML>  
<TITLE>Background Sound</TITLE>  
<HEAD>  
</HEAD>  
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<BGSOUND  
     SCR="sound/bgs.wav"  
     LOOP=-1>  
<BODY>  
    Enjoy my sound.  
</BODY>  
</HTML>  
----- 
Tag hình ảnh, phim <IMG>: Thêm hình ảnh hoặc phim vào trang web. Ðịnh nghĩa  
<IMG  
ALIGN=align-type  
ALT=text  
SRC=url  
BORDER=n  
HEIGTH=n  
WIDTH=n  
HSPACE=n  
VSPACE=n>  
Trong đó:  
- ALIGN=align-type: lề cho ảnh hay cho văn bản bao quanh ảnh. Giá trị có thể là TOP, MIDDLE, BOTTOM, 
LEFT, RIGHT.  
- ALT=text: văn bản hiển thị hay thay thế cho hình ảnh khi chức "Show Picture" trong trình duyệt bị tắt.  
- SRC=url: chỉ định ảnh  
- BORDER=n: đường viền ảnh. Nếu ảnh được dùng cho hyperlink thì đường viền có màu trùng với màu 
hyperlink. Nếu ảnh không dùng cho hyperlink thì đường viền không hiển thị.  
- HEIGTH=n,  WIDTH=n: chỉ độ cao và độ rộng của ảnh. Ðơn vị bằng pixel.  
- HSPACE=n, VSPACE=n: chỉ định khoảng cách từ ảnh đến văn bản quanh nó theo chiều ngang và dọc.  
Ví dụ:  
<A HREF="index.htm"><IMG SRC="images/btoc.gif" ALT="[các nội dung]" ALIGN=MIDDLE HSACE=5 
VSPACE=5>Nội dung</A></P>  
---------- 
Tag danh sách <UL><LI></UL>, <OL><LI></OL>: Danh sách sắp xếp (Ordered List), danh sách không sắp 
xếp(Unordered List) và danh sách các định nghĩa (Definition List). Danh sách sắp xếp bắt đầu bằng tag 
<OL>, danh sách không sắp xếp bắt đầu bằng 1 trong các tag sau: <UL>, <DIR> và <MENU>, danh sách các 
định nghĩa bắt đầu bằng tag <DL>. Ðể thể hiện mỗi một mẫu trong danh sách sắp xếp và không sắp xếp 
dùng tag <LI>.  
UL, DIR, MENU: danh sách không sắp xếp kiểu bullet, mỗi mẫu bắt đầu bằng tag LI.  
Ví dụ: danh sách kiểu bullet(không sắp xếp).  
<UL>  
<LI>Ðây là mục 1 trong danh sách.  
<LI>Ðây là mục 2 trong danh sách.  
</UL>  
Kết quả trình duyệt như sau:  

•   Ðây là mục 1 trong danh sách.  
•   Ðây là mục 2 trong danh sách.  

OL: danh sách sắp xếp. Mỗi mục trong danh sách cũng bắt đầu bằng <LI>.  
Ðinh nghĩa OL:  
<OL START=n  TYPE=order-type> trong đó:  
START=n: chỉ định chỉ số bắt đầu  
TYPE=order-type: chỉ định kiểu chỉ số. Có thể là một trong các giá trị sau:  
A:    sử dụng ký tự lớn A,B,C,...  
a:     sử dụng ký tự nhỏ a,b,c,...  
I:     sử dụng số La Mã lớn I,II,III,...  
i:     sử dụng số La Mã nhỏ i,ii,iii,...  
1:     sử dụng số 1,2,3,...  
Ví dụ:  
<OL TYPE=I>  
<LI>Nghi thức HTTP  
<LI>Nghi thức FTP  
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<LI>Nghi thức SMTP  
</OL>  
Kết quả trình duyệt như sau:  
I.       Nghi thức HTTP  
II.      Nghi thức FTP  
III.     Nghi thức SMTP  
DL: danh sách các định nghĩa, dùng với <DT> để chỉ định mẫu cần định nghĩa, và <DD> để chỉ định định 
nghĩa cho mẫu xác định bởi <DT>.  
Ví dụ:  
<DL>  
<DT>Tin học  
<DD>Môn khoa học nghiên cứu việc xử lý thông tin trên máy tính  
<DT>Sử học  
<DD>Môn khoa học nghiên cứu các biến đổi xã hội  
</DL>  
Kết quả trình duyệt như sau:  
Tin học  
        Môn khoa học nghiên cứu việc xử lý thông tin trên máy tính  
Sử học  
        Môn khoa học nghiên cứu các biến đổi xã hội  
-  
Tag định dạng bảng <TABLE><TR><TD></TABLE>: sử dụng tag <TABLE> để bắt đầu và kết thúc 1 bảng. 
Sử dụng kèm theo với tag <TR></TR> để thêm 1 dòng trong bảng và tag <TD></TD> để thêm vào 1 ô trên 
dòng.  
Ví dụ:  
<TABLE>  
<TR><TD>Ô 11<TD>Ô 12  
<TR><TD>Ô 21<TD>Ô 22  
</TABLE>  
Kết quả trình duyệt như sau:  
    Ô 11   Ô 12  
   Ô 21   Ô 22  
Ðể đóng khung cho bảng, sử dụng thuộc tính BORDER  
Ví dụ:  
<TABLE BORDER=1>  
<TR><TD>Ô 11<TD>Ô 12  
<TR><TD>Ô 21<TD>Ô 22  
</TABLE>  
Kết quả trình duyệt như sau:  

Ô 11  Ô 12  
Ô 21  Ô 22  

Chiều rộng mặc định của bảng sẽ là chiều rộng lớn nhất của dòng rộng nhất trong bảng. Ðể chỉ định chiều 
rộng các bảng, sử dụng thuộc tính WIDTH=n% để quy định chiều rộng.  
Ví dụ:  
<TABLE BORDER=1 WIDTH=100%>  
<TR><TD>Ô 11<TD>Ô 12  
<TR><TD>Ô 21<TD>Ô 22  
</TABLE>  
Kết quả trình duyệt như sau:  
Ô 11  Ô 12  
Ô 21  Ô 22  
Ðể thêm tiêu đề cho bảng, sử dụng tag <CAPTION></CAPTION>. Mặc định tiêu đề của bảng nằm ở trên và 
canh lề giữa. Tuy nhiên có thể thay đổi bằng cách dùng thuộc tính ALIGN bên trong CAPTION.  
Ví dụ:  
<TABLE BORDER=1 WIDTH=100%>  
<CAPTION> Tiêu đề của bảng</CAPTION>  
<TR><TD>Ô 11<TD>Ô 12  
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<TR><TD>Ô 21<TD>Ô 22  
</TABLE>  
Kết quả trình duyệt như sau:  
                   Tiêu đề của bảng  
Ô 11  Ô 12  
Ô 21  Ô 22  
    Ðể thêm vào các ô trải dài trên nhiều cột, dòng khác, dùng thuộc tính COLSPAN=n và ROWSPAN=n.  
Ví dụ:  
<TABLE BORDER=1 WIDTH=100%>  
<CAPTION> Tiêu đề của bảng</CAPTION>  
<TR><TD>Ô 11<TD COLSPAN=2>Ô 12 trải dài trên 2 ô  
<TR><TD>Ô 21<TD>Ô 22<TD>Ô 23  
</TABLE>  
Kết quả trình duyệt như sau:  
Ô 11  Ô 12 trải dài trên 2 ô  

Ô 21  Ô 22  Ô 
23 

Ðịnh nghĩa TABLE(bảng):  
<TABLE  
    ALIGN=align-type  
    BACKGROUND=url  
    BGCOLOR=color-type  
    BORDER=n  
    CELLPADDING=n  
    WIDTH=n%>  
Trong đó:  
    ALIGN=align-type: lề của bảng, có giá trị là LEFT hoặc RIGHT  
    BACKGROUND=url: chỉ định ảnh nền của bảng  
    BGCOLOR=color-type: màu nền của bảng  
    BORDER=n: đường viền bảng, n tính bằng pixel  
    CELLPADDING=n: khoảng cách từ ô tới nội dung của ô, đơn vị pixel  
    WIDTH=n: độ rộng của bảng, n tính theo % (phải có dấu % theo sau)  
Ðịnh nghĩa TR(dòng):  
<TR  
    ALIGN=align-type  
    BACKGROUND=url  
    BGCOLOR=color-type  
    VALIGN=v-align-type>  
Trong đó:  
    ALIGN=align-type: lề của các ô trong dòng, có giá trị là LEFT, RIGHT hoặc CENTER  
    BACKGROUND=url: chỉ định ảnh nền của dòng  
    BGCOLOR=color-type: màu nền của dòng  
    VALIGN=v-align-type: lề theo chiều dọc cho văn bản trong các ô trên dòng. Giá trị có thể là: TOP, 
BOTTOM, MIDDLE.  
Ðịnh nghĩa TD (ô):  
<TD  
    ALIGN=align-type  
    BACKGROUND=url  
    BGCOLOR=color-type  
    COLSPAN=n  
    ROWSPAN=n  
    VALIGN=v-align-type>  
Trong đó:  
    ALIGN=align-type: lề văn bản trong ô, có giá trị là LEFT, RIGHT hoặc CENTER  
    BACKGROUND=url: chỉ định ảnh nền cho ô  
    BGCOLOR=color-type: màu nền của ô  
    COLSPAN=n: ô trải rộng trên n cột  

  239 



Microsoft FrontPage 2002 
    ROWSPAN=n: ô trải dài trên n hàng  
    VALIGN=v-align-type: lề theo chiều dọc cho văn bản trong các ô  . Giá trị có thể là: TOP, BOTTOM, 
MIDDLE.  
TH: tạo ô tiêu đề. Tương tự như TD chỉ khác là văn bản được thể hiện ở dạng nghiêng.  
----------------------------------------------------  
Tag tạo Frame <FRAMESET><FRAME></FRAMESET>:  
Sử dụng tag <FRAMESET> và </FRAMESET> để chia cửa sổ trình duyệt thành nhiều cửa sổ con frame. Tag 
<FRAMESET> được dùng kèm với tag <FRAME> để định nghĩa 1 frame.  
Ví dụ: tạo trang web có tên là 2frame.htm chứa 2 frame, frame 1 bên trái chứa nội dung trang web 
page_1.htm và frame 2 bên phải chứa nội dung trang web page_2.htm.  
<html>  
<head>  
<title>Trang web có 2 khung</title>  
</head>  
<frameset cols="150,*">  
<frame name="muc_luc" target="noi_dung" src="http://bcvtth/html/page_1.htm">  
<frame name="noi_dung" src="http://bcvtth/html/page_2.htm">  
</frameset>  
</html>  
Mỗi frame có 1 tên, ví dụ frame trái có name="muc_luc" và frame phải có name="noi_dung". Ðể tạo liên kết 
từ frame muc_luc với frame noi_dung ta chỉ định trong frame muc_luc như sau:target="noi_dung". src=file: để 
chỉ định ra trang web thể hiện trên khung. Các trang web page_1.htm và page_2.htm cần tạo ra trước khi tạo 
trang web 2frame.htm chứa chúng. Nội dung của trang web page_1.htm trong tag <HEAD></HEAD> có khai 
báo sau:  
<head>  
<base target="noi_dung">  
</head>  
Ðể không xuất hiện scrollbar và border của frame, khi đó bạn thêm thuộc tính scrolling="no" và 
frameborder=0 vào tag <FRAME>, ví dụ:  
<frame name="muc_luc" target="noi_dung" src="http://bcvtth/html/page_1.htm" scrolling="no">  
Ðể tạo các liên kết hyperlink giữa trang page_1.htm với các trang web khác như page_2.htm, page_3.htm,... 
để thể hiện trên khung bên phải thì trong nội dung trang page_1.htm có nội dung như sau:  
<html>  
<head>  
<title>Trang mục lục</title>  
<base target="noi_dung">  
</head>  
<body>  
<p>Mục lục công việc</p>  
<p><a href="page_2.htm">page 2</a></p>  
<p><a href="page_3.htm">page 3</a></p>  
</body>  
</html>  
Khi đó trong trình duyệt bạn click vào các hyperlink thì các trang web page_2.htm và page_3.htm sẽ mở ra 
tương ứng ở frame bên phải(frame noi_dung) nhờ khai báo target="noi_dung".  
--- 
Liên kết đến 1 đoạn chỉ định trong tư liệu hiện hành hoặc một trang web khác  
Ðôi khi nội dung trang web dài và chiếm nhiều trang màn hình, nhưng nội dung lại có mối liên hệ chặt chẽ, 
hay vì 1 lý do nào đó mà ta không muốn toàn bộ nội dung này được chứa trong cùng 1 trang web và chia ra 
nhiều trang. Khi đó ta cần đặt các hyperlink ngay đầu trang web để khi cần người dùng có thể click vào đó để 
đi đến một đoạn tư liệu họ quan tâm mà không cần phải kéo scrollbar đến đoạn đó.  
Ðịnh nghĩa tag <A></A> như sau:  
1) Ðịnh nghĩa 1 bookmark và hyperlink trong cùng trang web: bookmark là kỹ thuật chỉ định 1 định 
danh(đích) để hyperlink nhảy đến đầu đoạn văn bản.  
<A name="name">chuỗi ký tự đầu đoạn văn bản</A> 
Ví dụ:  
<A name="Nd phần 1">Nội dung phần 1</A> bao gồm các nội dung chi tiết sau... 
Khi đó trong phần khai báo hyperlink bạn khai báo theo cú pháp sau: 
<a href="#tên_của_bookmark_đã_khai_báo">Chuỗi hướng dẫn nhảy đến đầu đoạn có 
bookmark="tên_của_bookmark_đã_khai_báo"</a> 
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Ví dụ: 
<a href="#Nd phần 1">Xem nội dung phần 1</a> 
2) Hyperlink đến một trang web khác:  
Cú pháp:  
<A HREF="địa_chỉ_trang_web_sẽ_nhảy_tới"> Chuỗi diễn giải hyperlink </A> 
Ví dụ: 
<A HREF="http://www.microsoft.com">Link đến trang web chủ của hãng máy tính Microsoft.</A>  
<A HREF="trang_chu.htm">Link đến trang web trang_chu.htm trong cùng thư mục.</A>  
<A TARGET="viewer" HREF="sample.htm">Click vào đây để mở trang web sample.htm trong cửa sổ 
"viewer".</A>  
<A HREF="http://www.microsoft.com"><IMG SRC="images/bullet.gif">Click vào ảnh này để link đến trang 
web của Microsoft</A>  
<A HREF="mailto:lava@pele.bigu.edu">lava@pele.bigu.edu</A><br> 

-  
Tag 6 mức tiêu đề <hN></hN>  
Dùng để tạo các chuỗi tiêu đề to nhỏ tùy ý tùy theo cấp tiêu đề đó trong trang web. Có 6 cấp tiêu đề khác 
nhau được định nghĩa như sau: 
<hN>Text xuất hiện trong tiêu đề</hN> 
với N là một số từ 1 đến 6  
Ví dụ: 

HTML Kết quả 

<H1>Tiêu đề cấp 1</H1> Tiêu đề cấp 1 
<H2>Tiêu đề cấp 2</H2> Tiêu đề cấp 2 
<H3>Tiêu đề cấp 3</H3> Tiêu đề cấp 3 

<H4>Tiêu đề cấp 4</H4> Tiêu đề cấp 4 

<H5>Tiêu đề cấp 5</H5> Tiêu đề cấp 5 
<H6>Tiêu đề cấp 6</H6> Tiêu đề cấp 6 
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Câu hỏi trắc nghiệm 
 
1. Bấm chuột phải tại cửa sổ FrontPage: 

A. Xoá đối tượng. 
B. Mở 1 menu tắt liệt kê các lệnh liên quan tới 

đối tượng. 
C. Chọn đối tượng. 
D. Không làm gì cả. 

2. Normal, HTML, và Preview là các cách khác 
nhau để: 

A. Khởi động FrontPage. 
B. Tổ chức các bìa hồ sơ. 
C. Xem các phim trên Web. 
D. Xem các trang trong FrontPage. 

3. Trong FrontPage bạn có thể cho thi hành lệnh 
bằng cách dùng: (Có thể chọn nhiều câu trả lời.) 

A. Menu 
B. Thanh công cụ. 
C. Phím tắt. 
D. Bấm chuột phải tại menu tắt. 

4. FrontPage là chương trình: (Có thể chọn 
nhiều câu trả lời.) 

A. Cho phép thiết kế và tạo ra trang tài liệu 
Word. 

B. Dùng cho các phóng viên tạo các trang tin. 
C. C.Dùng cho các nhà thiết kế đồ hoạ và Web 

masters. 
D. Cho phép thiết kế và tạo ra Web sites và 

xuất bản trên Internet. 
5. Để khởi động FrontPage : 

A. Bấm chuột ba lần, và đọc, “FrontPage ơi, 
mở ra.” 

B. Bấm Start → Programs → FrontPage. 
C. Bấm My Computer → Local Drive (C:) → 

FrontPage. 
D. Gõ “FrontPage” trong Microsoft Word, và 

bấm đúp để mở chương trình 
6. Một trang Web là: (Có thể chọn nhiều câu trả 
lời.) 

A. Một kiểu tài liệu Word có thể chia sẻ trên 
mạng. 

B. Một tài liệu tạo ra trong Microsoft FrontPage 
để  xuất bản trên Internet. 

C. Một phần của Web site. 
D. Một bản thảo . 

7. Thời gian Download ước lượng là: (Có thể 
chọn nhiều câu trả lời.) 

A. Thời gian trung bình để tải trang về từ 
Internet. 

B. Thời gian đi xuống phố. 
C. Lượng thời gian cần thiết để tải trang về 

máy. 
D. Phu thuộc vào kiểu modem . 

8. Cách tiết kiệm thời gian tạo Web site? (Có thể 
có nhiểu trả lời.) 

A. Dùng một mẫu Web site (Template). 

B. Dùng chức năng Web site Magician. 
C. Dùng chức năng Web site Wizard. 
D. Nhập từ một Web site khác. 

9. Tổ hợp phím nào tạo một dòng mới trong đoạn 
văn bản? 

A. <Alt> + <A>. 
B. <Shift> + <Enter>. 
C. <Ctrl> + <A>. 
D. <Ctrl> + <L>. 

10. Phím Backspace xoá văn bản phía trái điểm 
nháy. (Đúng/Sai?) 
11. Bạn vô tình xoá đoạn văn bản mới tạo xong. 
Làm cách nào khôi phục văn bản bị mất? 

A. Chọn Help và sử dụng Search Companion để 
tìm văn bản trên máy tính. 

B. Bấm nút Undo trên thanh công cụ chuẩn. 
C. Vào chế độ Preview để lấy lại khối văn bản đã 

xoá. 
D. Không thể làm gì được. 

12. Cách nào sau đây không dùng để cắt văn bản 
hay hình ảnh? 

A. Bấm nút Cut trên thanh công cụ chuẩn. 
B. Nhấn <Ctrl> + <C>. 
C. Nhấn <Ctrl> + <X>. 
D. Chọn Edit → Cut từ menu. 

13. Làm cách nào tạo ra trang mới? (Có thể chọn 
nhiều câu trả lời.) 

A. Chọn File → New → Page từ menu, chọn một 
khuôn mẫu từ hộp thoại, 

A. và bấm OK. 
B. Nhấn <Ctrl> + <N>. 
C. Bấm nút New Page button trên thanh công cụ 

chuẩn. 
D. Chọn toàn bộ trang đang làm việc và xoá nội 

dung của nó. 
14. Chế độ HTML view trong FrontPage khác với 
Normal và Preview view ở chỗ: 

A. HTML view thiên về văn bản hơn Normal 
Preview view. 

B. Trang Web có nhiều hình hơn 
C. HTML view hiển thị các mã định dạng theo 

ngôn ngữ HTML . 
D. HTML view là dễ đọc hơn Normal và Preview 

view. 
15. Tiêu đề của trang cũng chính là tên tập tin 
HTML. (Đúng/Sai?) 
16. Bạn thiết kế một Web site quan trọng cho công 
ty, site này sẽ được xuất bản trên Internet trong 
một khoảng thời gian ngắn. Bạn cần chú ý điều gì 
trước khi tải lên (upload) lên Internet? 
(Có thể chọn nhiều câu trả lời.) 

A. Xem trước trong Microsoft Internet Explorer. 
B. Xem trước trang trong các trình duyệt khác 

nhau. 
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C. In ra và hiệu chỉnh. 
D. Không phải các câu trên. 

17. Danh sách thư mục (Folder List) là: 
A. Một danh sách các thư mục trên máy tính. 
B. Một tính năng không hiệu quả của 

FrontPage chỉ tổ chiếm chỗ trên màn hình. 
C. Một tính năng tự động lập sơ đồ Web site. 
D. Có thể dễ dàng truy cập trên thanh công cụ 

chuẩn. 
18. Di chuyển (Navigating ) giữa các trang Web 
là tương tự như duyệt Internet. (Đúng/Sai?) 
19. Tiêu đề của trang Web xuất hiện: 

A. Trên đầu cửa sổ trình duyệt. 
B. Tại phần tên của trang trong Folders View. 
C. Tại ngay đầu trang . 
D. Tại phía dưới cửa sổ, gần với thời gian tải 

ước lượng. 
20. Khi nào thì dùng lệnh Save As trong menu 
File thay cho lệnh Save ? 

A. Để lưu dưới một tên mới hoặc một vị trí 
mới. 

B. Để gửi email cho ai đó. 
C. Để tiết kiệm thời gian 
D. Để chỉ định Frontpage luôn luôn tạo ra một 

bản sao dự phòng. 
21. Bạn chỉ có thể di chuyển hay sao chép văn 
bản bằng các lệnh Copy, Cut, và Paste 
(Đúng/Sai?) 
22. Thủ tục nào sau đây cho phép thay đổi kích 
cỡ font? 

A. Chọn văn bản và chọn font size hộp danh 
sách cỡ Font  trên thanh công cụ. 

B. Chọn văn bản, Bấm chuột phải , chọn  Font 
từ menu tắt, chọn kích cỡ font và bấm OK. 

C. Chọn văn bản, chọn Format → Font từ 
menu, chọn font size , bấm OK. 

D. Không phải ba câu trên 
23. Để sao chép định dạng ta có thể sử dụng:: 

A. Lệnh Edit → Copy Format và Edit → Paste 
Format từ menu. 

B. Nút  Format Painter trên thanh công cụ 
chuẩn. 

C. Không có cách nào. 
D. Mở hộp thoại Copy and Apply Formatting  

bằng cách chọn Format → Copy Formatting 
từ menu. 

24. Bạn muốn sử dụng Format Painter để áp đặt 
định dạng cho nhiều khối văn bản không liên 
tiếp. Làm cách nào để thực hiện? 

A. Bấm  nút Format Painter trên thanh công cụ 
chuẩn. 

B. Bấm đúp Format Painter trên thanh công cụ 
chuẩn. 

C. Không có cách nào. 
D. Mở hộp thoại Copy and Apply Formatting  

bằng cách chọn Format → Copy Formatting 
từ menu. 

25. Câu nào sau đây là không đúng? 
A. Bấm nút Center trên thanh công cụ định dạng 

sẽ canh giữa các văn bản thuộc đoạn hiện 
hành 

B. Sử dụng thanh công cụ định dạng là cách dễ 
nhất để định dạng văn bản. 

C. Khi thụt lề dòng đầu tiên, mọi dòng dầu tiên 
sau đó đều bị thụt lề 

D. Một kiểu thụt lề đặc biệt là First line. 
26. Cách nào sau đây không tạo chữ đậm? 

A. Chọn Format → Font từ menu và chọn Bold từ 
danh sách Font style. 

B. Nhấn <Ctrl> + <B>. 
C. Bấm chuột phải tại văn bản và chọn Boldface 

từ menu tắt. 
D. Bấm nút Bold trên thanh công cụ định dạng. 

27. Khi nhấn <Enter> đề tạo một đoạn mới , đoạn 
đó sẽ có định dạng y hệt đoạn trước (Đúng/Sai?) 
28. Để canh giữa một đoạn văn bản? 

A. Bấm nút  Center trên thanh công cụ định dạng. 
B. Bấm mũi tên Alignment trên thanh công cụ và 

chọn Center. 
C. Nhấn <Ctrl> + <C>. 
D. Chọn Edit → Center từ menu. 

29. Làm cách nào thay đổi ký hiệu đánh dấu đoạn 
trong một bulleted list? 

A. Bấm mũi tên  Bullets trên thanh công cụ định 
dạng và chọn ký tự. 

B. Không thể thay đổi 
C. Chọn Edit → Bullet Symbol từ menu, chọn 

bulleted list , bấm Customize, và chọn ký tự 
cần. 

D. Chọn Format → Bullets and Numbering từ 
menu, chọn bulleted list , bấm Customize, và 
chọn ký tự cần. 

30. Để thay đổi màu nền của trang Web ? 
A. Bấm nút Background trên thanh công cụ định 

dạng và chọn màu nền. 
B. Chọn văn bản và bấm nút Underline trên thanh 

công cụ Formatting . 
C. Chọn Format → Background từ menu và chọn 

màu nền. 
D. Bấm chuột phải tại trang và chọn Page 

Properties → Background , và chọn màu nền. 
31. Tất cả các chương trình phát triển Web đều 
dùng themes. (Đúng/Sai?) 
32. Phân biệt giữa themes và cascading style 
sheets? (Chọn nhiều câu trả lời.) 

A. Không phân biệt. 
B. Các styles trong themes được tạo ra mỗi khi 

tạo ra các styles trong cascading style sheets. 
C. Themes chỉ có thể áp dụng cho 1 trang trong 

Web site, trong khi cascading stylesheets áp 
dụng cho tất cả các trang trong Web site. 

D. Cascading style sheets thay đổi style của trang 
qua các thẻ HTML đặc biệt, trong khi themes là 
một tập hợp các styles được áp đặt 1 lần. 
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33. Câu nào sau đây là đúng? 
A. Ảnh thu nhỏ (Thumbnail) liên kết tới ảnh 

thật. 
B. Một trang có ảnh lớn cần ít thời gian 

download hơn một trang có ảnh nhỏ. 
C. Cắt xén (Cropping) ảnh làm giảm kích 

thuớc và chất lượng của ảnh. 
D. Văn bản thay thế xuất hiện ngay phía dưới 

của hình trên trang. 
34. Bạn muốn đưa ảnh của con chó Kiki vào 
trang Web, nhưng bạn chỉ có duy nhất 1 tấm 
hình của Kiki chụp chung với gia đình. Làm 
cách nào bây giờ? 

A. Thay đổi kích thước (Resize) hình. 
B. Tạo một ảnh thu nhỏ (thumbnail image). 
C. Canh thẳng hàng (Realign the image). 
D. Cắt xén ảnh (Crop the image). 

35. Thay đổi định dạng tệp của một ảnh luôn 
luôn làm giảm kích thước tệp. (Đúng/Sai?) 
36. Ảnh trong ClipArt thường có dạng GIF . 
(Đúng/Sai?) 
37. Một đường biên xanh bao quanh ảnh có 
nghĩa là: 

A. Người đọc đã vào Website. 
B. Ảnh có chứa một liên kết. 
C. Có văn bản ghi chú phía dưới ảnh. 
D. Ảnh được lấy từ Internet. 

38. Bạn đã tạo 1 trang Web có khá nhiều hình 
nhưng chưa có thông tin ghi chú liên quan. Làm 
cách nào đưa thông tin đến người xem ? 

A. Tạo một liên kết từ ảnh đến một trang cùng 
chủ đề. 

B. Thêm văn bản ghi chú cho ảnh. 
C. Cho người đọc một địa chỉ liên hệ tác giả 

của ảnh. 
D. Cho email của bạn để người đọc hỏi thăm 

khi nào cần thiết. 
39. Một hotspot là: 

A. Trang Web phổ biến nhất trong một Web 
site. 

B. Một liên kết ổn định trên trang Web. 
C. Một vùng trên lò sưởi có nhiệt độ cao. 
D. Một vùng trên ảnh có chứa liên kết. 

40. Câu nào sau đây là không đúng? 
A. Ảnh nền sẽ làm tăng thời gian download 

của trang. 
B. Di chuyển một ảnh trên trang cũng giống 

như định vị ảnh 
C. Văn bản ghi chú cuả một ảnh chỉ xuất hiện 

khi người đọc tắt chức năng xem ảnh trên 
trình duyệt 

D. Một đường biên xung quanh ảnh dùng đề 
nhấn mạnh ảnh đó 

41. Cảnh thẳng hàng (Aligning) một ảnh sẽ làm 
cho văn bản xung quanh: 

A. Bao xung quanh ảnh. 
B. Nổi lên trên ảnh. 

C. Cũng được canh thẳng hàng cùng tính chất. 
D. Được hiển thị dưới dạng mã HTML. 

42. Loại ảnh nào sau đây không được dùng trên 
Internet? 

A. JPEG 
B. GIF 
C. BIT 
D. PNG 

43. Shared borders có thể hiển thi trên phần nào 
của trang WEb? ( Có thể chọn nhiều câu trả lới.) 

A. Bottom 
B. Right 
C. Left 
D. Top 

44. Câu nào sau đây là không đúng? 
A. Hyperlinks có thể xuất hiện trong một trang 

Web. 
B. Hyperlinks có thể thêm vào trong chế độ 

Navigation view. 
C. Hyperlinks trong một trang Web được hiển thị 

trong chế độ Hyperlinks view. 
D. Hyperlinks xuất hiện dưới bất kì màu nào trên 

trang. 
45. Chế độ Preview view là một cách để kiềm tra 
siêu liên kết. (Đúng/Sai?) 
46. Có thể thêm một trang vào Web site trong chế 
độ Normal view. (Đúng/Sai?) 
47. Khi nào thì ta nên tạo ra hyperlink? (Có thể 
chọn nhiều câu trả lới.) 

A. Để cung cấp cho người đọc thêm thông tin liên 
quan. 

B. Không có hyperlinks, trang Web cuả bạn rất 
nhàm chán. 

C. Để thêm sự đa dạng vào trang Web. 
D. Để lấy phản hồi về Web site. 

48. Hyperlinks có thể liên kết đến các đích sau: (Có 
thể chọn nhiều câu trả lời.) 

A. Địa chỉ e-mail 
B. Một tập tin âm thanh 
C. Một video clip 
D. Một vị trí trên cùng một trang 

49. Một thanh liên kết (link bar) là một công cụ giúp: 
A. Đi biển. 
B. Tài xế cuả các xe hơi đắt tiền. 
C. Người dùng di chuyển trong Web sites. 
D. Shared borders định vị các vị trí trong một Web 

site. 
50. Câu nào sau đây là đúng? 

A. Shared borders tự động hình thành các nút di 
chuyển. 

B. Xoá một liên kết cũng có nghiã là xoá tập tin 
liên kết. 

C. Chế độ Navigation view  cho phép di chuyển 
nhanh hơn trong  web site . 

D. Có thể thêm một trang trong Web site trong chế 
độ Navigation View. 

51. Cách nào sau đây không thể tạo được bảng? 
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A. Chọn Table ->Insert Table  từ menu. D. Đặt điểm nháy trong bảng, chọn Tables-> 
properties->Table từ menu, và thay đổi thông 
tin trong vùng Border. 

B. Bấm nút Insert Table trên thanh công cụ. 
C. Chọn Insert ->Table  từ menu. 
D. Chọn View ->Toolbars ->Tables and 

Borders để hiển thị thanh công cụ Tables 
and Borders rồi sử dụng nút Draw Table để 
kẻ bảng. 

52. Câu nào sau đây là không đúng? 
A. Có thể thực hiện định dạng ký tự và định 

dạng đoạn trong table. 
B. Có thể sắp xếp thông tin trong một bảng 

theo thứ tự được chỉ định. 
C. Có thể tách một ô thanh nhiểu ô nhỏ, hoặc 

gộp nhiều ô thanh một ô chung. 
D. FrontPage  không thể thực hiện các tính 

toán trong bảng. 
53.  Phím nào sau đây có thể dùng để nhập dữ 
liệu và di chuyển trong table? 

A. <Tab>  để di chuyển qua ô kế tiếp, <Shift> 
+ <Tab>  để đi theo hướng ngược lại. 

B. <Enter> để di chuyển qua ô kế tiếp, <Shift> 
+ <enter>  để đi theo hướng ngược lại. 

C. < Mũi tên > để di chuyển qua ô kế tiếp, 
<Shift> + < mũi tên >  để đi theo hướng 
ngược lại. 

D. Tất cả đều đúng. 
54. Không thể chèn một ảnh vào trong một Table 
. (Đúng/Sai?) 
55.  Câu nào sau đây là không đúng? 

A. Chức năng AutoFit  tự động điều chỉnh bề 
rộng của cột. 

B. Ta có thể ngăn không cho một hàng bị ngắt 
trang bằng cách: Vào menu Table, chọn 
Cell Height and Width, đánh dấu  Allow row 
to break across pages. 

C. Đường lưới của bảng thì luôn luôn xuất 
hiện khi in. 

D. Có thể trộn nhiều ô thành một và có thể 
tách một ô thanh nhiều ô. 

56. Thủ tục nào sau đây được sử dụng để kề 
đường biên cho một bảng? 
(có thể chọn nhiều câu trả lời) 

A. Chọn khối ô, sau đó chọn đường kẻ trong 
nút Borders của thanh công cụ định dạng 
hoặc của thanh công cụ Tables and 
Borders. 

B. Chọn Tables ->Table Border Wizard từ 
menu và thực hiện theo hướng dẫn. 

C. Bấm nút Draw Table trên thanh công cụ 
Tables and Borders và sau đó vẽ đường 
biên. 

57. Muốn trộn 4 ô thanh một ô lớn. Cách nào sau 
đây có thể thực hiện được ( có thể chọn nhiều câu 
trả lời) 

A. Chọn 4 ô và bấm nút  Merge Cells  trên thanh 
công cụ Tables and Borders. 

B. Chọn 4 ô và chọn Table ->Merge Cells  từ 
menu. 

C. Chọn 4 ô và chọn Table ->Combine Cells từ 
menu. 

D. Chọn 4 ô rồi nhấn <Ctrl> + <M>. 
58. Khác biệt duy nhất giữa cell padding và cell 
spacing là : cell padding thay đổi bề rộng cuả biên 
ở giữa các ô. (Đúng/Sai?) 
59. Nên chỉ định kích thước table bằng pixels hoặc 
percent, bởi vì trang Web không hiển thị giống 
nhau trên mỗi màn hình. (Đúng/Sai?) 
60. cách nào sau đây dùng để tạo frame? (Có thể 
chọn nhiều câu trả lời.) 

A. Chọn New → Insert → Frame từ menu. 
B. Bấm nút Insert Frame trên thanh công cụ 

chuẩn. 
C. Chọn File → Page, chọn thẻ Frames Pages , 

chọn kiểu frame, và bấm OK. 
D. Bấm nút New Page, chọn Page → Frame. 

61. Câu nào sau đây là không đúng? 
A. Ta có thể thay đổi kích thước frame, và cho 

phép cả người dùng cũng có quyền thay đổi 
kích thước đó trong cửa sổ trình duyệt. 

B. Frame cho phép người dùng xem nhiều trang 
cùng một lúc. 

C. Có thể tách một frame thành nhiều frame nhỏ. 
D. Sau khi tạo ra frame trong Web site, tất cả mọi 

trang đều là trang frame. 
62. Khi tạo một trang mới gồm 2 frame, cần lưu 3 
lần. (Đúng/Sai?) 
63. Cascading Style Sheets là tập hợp các style liên 
kết đến trang Web. (Đúng/Sai?) 
64. Các định dạng nào sau đây có thể định nghĩa 
trong một style? 

A. Paragraph  
B. Font 
C. Numbering 
D. Border 
E. All of the above 

65. Tạo một style giống như là định nghĩa lại các 
thẻ  HTML. (Đúng/Sai?) 
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